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Preface
Master the essentials of FileMaker 13
Congratulations on selecting the FileMaker Training Series! The FileMaker Training 
Series: Basics and the FileMaker Training Series: Advanced make up the official 
curriculum for learning how to use FileMaker software to build professional solutions.

The FileMaker Training Series: Basics focuses on the features and benefits of the 
FileMaker Platform with special attention to the newest version, FileMaker 13. You will 
learn how to build a sample FileMaker solution from start to finish.

The FileMaker Training Series: Advanced is for intermediate to advanced FileMaker 
developers, but anyone who creates FileMaker databases can increase their knowledge 
from this series. It also serves as a stepping-stone to becoming a FileMaker 13 Certified 
Developer. FileMaker Training Series: Advanced is a separate purchase.

Necessary materials
The FileMaker Training Series: Basics training has activities to guide you through the 
FileMaker Platform. In order to follow along, make sure you have the following materials. 

Software
Before you begin the training, you will need the following software:

FileMaker Pro 13 – download 30-day trial:
http://www.filemaker.com/trial

FileMaker Go 13 – free download from the App Store:
http://www.filemaker.com/fmgo
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Activity files
The activities in this training will use the following files:

• Contacts.fmp12

• Customers.xlsx

• Assets.xlsx

Solution File
This is an example of the finished solution being built in this training:

• Equipment Rentals.fmp12

To download the activity and solution files, visit:
http://www.filemaker.com/r/fts_basics_activities

Acknowledgment
Special credit to Soliant Consulting, Inc. for the development of this curriculum. A 
platinum member of the FileMaker Business Alliance, Soliant Consulting specializes in 
FileMaker Pro development, training, and consulting; the company has offices in 
Chicago, the San Francisco Bay Area, and Philadelphia.

    http://www.soliantconsulting.com
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Introduction
What if you could streamline your business by creating custom solutions that transform 
the way you and your team work? Instead of relying on spreadsheets, paper forms, or 
multiple applications to get your work done, connect your team together with interactive 
screens, reports, and dashboards that deliver all the information they need in one place. 
The FileMaker platform puts you in control, providing an easy way to create database 
solutions that meet the specific needs of your business.

FileMaker, Inc. is a subsidiary of Apple. Millions of people, from individuals to some of 
the world's largest companies, rely on the FileMaker Platform to manage, analyze and 
share important information. The software is available in over 60 countries in 17 
languages and is used by several different types of organizations including government, 
education, healthcare, retail, manufacturing, real estate, legal and more.

The FileMaker Platform is a line of products that work together to streamline your 
business. You can easily create solutions to manage and share information with your 
team on iPad, iPhone, Windows, Mac and the web.

FileMaker databases are generally referred to as “solutions.” FileMaker solutions bring 
together many software elements to solve business problems. Solutions built with the 
award-winning FileMaker Platform are used to streamline a wide range of functions like 
project management, asset management, invoicing and billing, and customer 
relationship management (CRM).

The training available for the FileMaker Platform is:

• Getting Started Tour in FileMaker Pro and FileMaker Go take you through the key 
features so you can start to build and use a solution immediately.

• FileMaker Training Series: Basics builds on the Getting Started Tour and 
introduces how you can use the FileMaker Platform to create and deploy custom 
data management solutions. 

• FileMaker Training Series: Advanced provides in-depth coverage of development 
practices and techniques for FileMaker developers.

The FileMaker Training Series: Basics focuses on the features and benefits of the 
FileMaker Platform with special attention to the newest version, FileMaker 13. For 
simplicity, "FileMaker" is used throughout the training except in cases where a feature is 
specific to FileMaker 13.
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You will learn the capabilities of the key products for creating solutions, FileMaker Pro 
and FileMaker Pro Advanced. FileMaker Pro Advanced has all the features to create 
solutions that are included in FileMaker Pro plus a suite of advanced development and 
customization tools. But for simplicity, "FileMaker Pro" is used when referring to the 
software used to create solutions.

FileMaker Training Series: Basics assumes that you have FileMaker Pro installed on your 
Mac or Windows computer and FileMaker Go installed on your iOS device. Activities are 
included in the training that require you to use both products.

The FileMaker Training Series: Basics is organized as follows:

• In Lessons 1 - 2, you will be introduced to:

The FileMaker Platform

FileMaker Starter Solutions

• In Lessons 3 - 4, you will learn about using a FileMaker solution and how to:

Navigate a FileMaker solution

View and modify data in a solution

Find and sort data in a solution

• In Lesson 5, you will learn about user-centered design including:

Planning a solution to solve the right problems

A sample scenario used for the rest of the lessons

• In Lessons 6 - 8, you will learn about data and how to:

Import data into a FileMaker solution

Create tables, fields, and relationships for your data

• In Lessons 9 - 13, you will learn about user interface design and how to:

Use themes, styles, guides and other FileMaker design tools

Create interfaces for iOS devices

Create efficient interfaces for the user
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• In Lessons 14 - 19, you will learn about powerful tools in the FileMaker Platform 
including:

Calculations, Scripting and Reporting

Integration with other business systems

Security

Sharing and deployment of your solution to other users

We appreciate your interest in learning how FileMaker can solve your business 
challenges. We support you in your training process and encourage you to visit the 
FileMaker Forum at http://www.filemaker.com/forum and post any questions you
may have.
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Lesson 1

FileMaker Platform Overview

Time: This lesson takes approximately 20 minutes 
to complete.



Objectives: FileMaker Platform

After this lesson, you will be able to:

• Identify the four products of the FileMaker Platform

• Identify the requirements for building, accessing, and hosting FileMaker 
solutions

• Compare and contrast FileMaker Pro and FileMaker Go

• List the additional features in FileMaker Pro Advanced

• Describe real-world uses of FileMaker solutions

The FileMaker 13 Platform is a set of tools and technologies that enable you to create, 
deploy, and manage custom business solutions, as well as modify them as your needs 
change. You can create solutions that run on iPad, iPhone, Mac, Windows, and the 
web.

Solutions that are well designed allow easy collection and sharing of data in various 
locations, such as customer information at a sales event and safety checklists at a 
worksite. Imagine, for example, a safety inspector collecting data in the field with 
FileMaker Go for iPad—taking pictures, entering notes, and uploading the data to 
FileMaker Server so that FileMaker Pro users in the office can see and use the data right 
away. The products that make up the FileMaker Platform work together to let users see 
and interact with the same information in real time.

In this lesson, you will learn about the different products in the FileMaker Platform, what 
they do, and how they work together.
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What are FileMaker Solutions?
A FileMaker solution is made up of one or more files that resolve business issues and 
improve data management. Well designed solutions that are customized to meet the 
specific needs of a business, help employees do their jobs more quickly and easily, 
reduce operating costs, and enhance customer satisfaction.

A custom FileMaker solution may contain the following components:

Data
Almost every application today—an online catalog, an address book, a calendar—is 
driven by a database engine. All these applications store and retrieve a variety of data in 
a structured format. 

A database contains two parts: a data structure and the data that lives within that 
structure. FileMaker has a database at its core for creating structure like tables, fields, 
and relationships. This provides the foundation for users to interact with the data stored 
in the structure.

Interface
In a solution, the interface provides users with a way to view and interact with the data. 
A well designed solution will incorporate business rules for what and how the user 
enters, finds, and views data. The interface revolves mostly around layouts and layout 
objects.

Solution Logic
Solution logic adds automation to make users more productive. The two main tools 
FileMaker Pro provides for automating solution logic are calculations and scripting. 
Calculations provide access to complex, calculated data, requiring less interaction from 
users. Scripts allow users to complete tasks quickly and efficiently by automating 
certain portions of the business process or by guiding the users through the process. 
Both scripts and calculations increase data integrity by standardizing business 
processes.
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Reporting
FileMaker Pro provides step-by-step reporting tools, including eye-catching charts to 
help analyze and summarize data in meaningful ways. You can easily create and email 
reports in Excel or PDF format to share with others. FileMaker makes this possible by 
combining data, interface, and solution logic.

Integration
Integrating a FileMaker solution with other technologies can improve the efficiency of 
your workgroup and extend the capabilities of a solution. The FileMaker platform allows 
you to import and export to file formats like Excel and comma-separated text, work with 
data in ODBC compatible systems like SQL Server and MySQL, display web pages on 
your layouts, and much more.

Security
Security is a critical component of any modern system. FileMaker Pro has built-in tools 
that allows you to manage the security of your FileMaker solution. You can restrict 
access to entire FileMaker files as well as individual tables, records, fields, layouts, 
scripts, and so on.

Deployment
Providing access to a solution by one or more users is possible through FileMaker 
deployment capabilities. FileMaker solutions are often hosted on FileMaker Server, 
giving consistent access to multiple users, as well as providing other benefits like 
automated backups and secure data connections.

The FileMaker Advantage
The FileMaker Platform combines data structure, interface, scripting, and calculations to 
create a cohesive developer and user experience. Since these tools are available in a 
single platform, a separate database administrator, UI designer, and programmer are not 
always necessary to create a business solution. With the help of the tools and templates 
provided within FileMaker products, a single knowledge worker with a solid 
understanding of the FileMaker Platform can create a custom solution for their 
department or organization.
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FileMaker solutions can often be created in days or weeks rather than months or years. 
Modifications and feature additions can be done in minutes or hours. 

You can start small and grow your solution over time. Keep in mind that building more 
complex solutions requires planning, preparation, and knowledge of the product 
features. The FileMaker Training Series provides instruction on these steps.
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Product Line
How Products Work Together
The FileMaker Platform is a line of products that work together to help you streamline 
your business. 

You start with FileMaker Pro on a Windows or Mac computer to create your custom 
business solution. Or consider FileMaker Pro Advanced for additional development and 
customization tools.

To run your solution on iPad or iPhone, use the free FileMaker Go app which is available 
on the App Store.

For a small team with occasional access, FileMaker Pro can share solutions with up to 5 
other FileMaker Pro or FileMaker Go users (shown in Figure 1).

FIGURE 1

For larger groups and essential business solutions, FileMaker Server is a better option. 
Along with sharing, FileMaker Server also provides additional security and many robust 
features, including the ability to access your solution from a web browser, using 
FileMaker WebDirect or Customer Web Publishing technologies (Figure 2).
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FIGURE 2

Knowing how users will connect to your solution helps determine what to purchase. 
Users with a paid license of FileMaker Pro on Windows or Mac can connect to 
FileMaker Server for no additional cost. Users with web browsers, or users running 
FileMaker Go on iPad and iPhone, require paid connections to FileMaker Server. These 
are called concurrent connections.

For example, a team with several members connects to FileMaker Server using an iPad, 
iPhone, or web browser throughout the day. At various times, there are different 
numbers of users connected (as shown in Figure 3). The number of concurrent 
connections needed is determined by the maximum number of people connected at any 
one time using an iPad, iPhone, or web browser.

FIGURE 3
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FileMaker Server comes with one concurrent connection so you can test your solution 
using an iPad, iPhone, or web browser. You can purchase additional concurrent 
connections in groups of 5.

For example, if the maximum number of people connected at any one time using an 
iPad, iPhone, or web browser is 8, you will need to purchase two groups of 5 concurrent 
connections to equal 10 connections. As your team grows, you can add more 
concurrent connections in groups of 5.

If you need more than 50 concurrent connections, purchase a FileMaker Server with 
Unrestricted Concurrent Connections. This server removes the restrictions on the 
number of concurrent connections and is limited only by your hardware configuration 
and the complexity of your solution.

In summary:

• Use FileMaker Pro or FileMaker Pro Advanced to create and run solutions on 
Windows or Mac. Purchase a FileMaker Pro license for each Windows and Mac user.

• Use FileMaker Go to run solutions on iPad or iPhone. Download the free FileMaker 
Go app for each iPad and iPhone user.

• When using FileMaker Server to share your solution with larger teams and to enable 
web browser connections, purchase licenses of FileMaker Pro for all your Windows 
and Mac users and purchase the appropriate number of concurrent connections for 
your iPad, iPhone, and web browser users.

Product Descriptions in Detail
While the products in the FileMaker Platform are designed to work together, they each 
have their own roles and capabilities. For the latest technical specs and hardware 
requirements, visit the FileMaker website.

FileMaker Pro 13

FileMaker Pro is desktop software for Windows and Mac that allows you to design and 
build custom solutions, and to use solutions built by others.

FileMaker Pro provides tools to define data structure, create layouts to view data, and 
share data with up to five other network connected users, called “peer-to-peer" sharing. 
(The "peer-to-peer" data sharing works well for lightweight uses, but FileMaker Server is 
the best tool for sharing FileMaker solutions.)
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FileMaker Pro 13 Advanced

FileMaker Pro Advanced is also desktop software for Windows and Mac and has all the 
features of FileMaker Pro plus additional programming and development tools, including 
script debugging, and the ability to create custom menus and database design reports.

The Script Debugger and Data Viewer are useful troubleshooting tools for solution logic. 
The Script Debugger allows developers to walk through scripts step by step for testing 
purposes. The Data Viewer can be used to monitor fields and variables while scripts are 
running and write and test calculations before using them for real business purposes.

There are also tools for customization of a solution. Custom Menus let FileMaker 
developers take control of the organization and behavior of the menubar, and Custom 
Functions let FileMaker developers create their own functions to use in the FileMaker 
calculation dialog.

FileMaker Pro Advanced also contains tools for creating a Database Design Report 
(DDR), which documents the internal structure of a FileMaker solution. FileMaker Pro 
Advanced is also necessary in order to enable features like file encryption and kiosk 
mode for your solution.

The additional tools in FileMaker Pro Advanced are an essential part of a developer’s 
toolkit, making it a must-have product for those who will be creating or maintaining 
solutions. 

FileMaker Go 13

The FileMaker Go app allows users to access FileMaker solutions on iOS devices, 
including iPad, iPad mini, iPad Air, iPhone, and iPod touch. The app provides access to 
hosted (online) or locally stored (offline) FileMaker solutions.

For FileMaker solutions that are hosted, the iOS device must be connected to a network 
via Wi-Fi or a cellular connection to access the solution. Similar to FileMaker Pro, data 
entered while working on a mobile device will be immediately available to all other 
connected users.

FileMaker Go can also access a FileMaker solution stored locally on the device for 
offline use. By using FileMaker scripting or a commercial solution, the offline data can 
later be synchronized with a hosted solution for sharing among many users.
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FileMaker Server 13

FileMaker Server software acts as a server for hosting FileMaker solutions. Hosted 
solutions can be used by hundreds of people at the same time with the data shared 
securely between the server and users. FileMaker Server can also allow access to 
FileMaker solutions via FileMaker WebDirect, which provides access through a user's 
web browser.

FileMaker Server can:

• Run scheduled, automated backups of database files 

• Log usage and performance statistics 

• Execute server-side scripts, including FileMaker scripts and system-level scripts 
(including Windows batch, Perl, VBScript, and AppleScript) 

• Provide secure data transfer over networks 

• Deploy a solution to anyone with a compatible web browser, without using web 
authoring tools or other technologies, via FileMaker WebDirect

FileMaker Server also includes the FileMaker API for PHP and XML Custom Web 
Publishing (CWP). Developers who are skilled in those technologies can use this API to 
build dynamic websites that interact with FileMaker solutions.
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FileMaker Version Compatibility
The FileMaker 13 Platform uses a specific file format that has been available since 
FileMaker 12. Files created in this format have the extension of .fmp12. For users of 
FileMaker versions prior to 12, it will be necessary to convert older file formats to the 
new .fmp12 format before taking advantage of FileMaker 13. 

More information on converting to FileMaker 13 can be found here: 
http://www.filemaker.com/products/filemaker-pro/conversion.html
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Accessing a Solution
When building a FileMaker solution, it helps to keep in mind how it will be accessed. A 
single FileMaker solution can provide different functionality based on the platform from 
which it is accessed. For example, people using the same solution may use:

• FileMaker Pro as a robust way to create, edit, and review orders

• FileMaker Go to change the status of an order while in the warehouse, get a 
signature from the recipient, and email the client a receipt of the order

• Web browser via FileMaker WebDirect for clients to check the status of their order

FileMaker Pro has the flexibility and power for you to build layouts for all platforms in 
one solution. Following are the benefits of each product and platform:

FileMaker Pro

FileMaker Pro takes full advantage of the screen size and processing power of being a 
native app on Windows and Mac.

FileMaker Go

FileMaker Go benefits from being on an iOS device, making your data more portable. It 
also takes advantage of some device specific features:

• Take a photo or record a video with the built-in camera and store it in a FileMaker 
solution

• Enter or find data by using the camera as a bar code scanner

• Dial phone numbers stored in a FileMaker solution

• Add location data (latitude and longitude) to records

• Capture signatures

FileMaker WebDirect

FileMaker WebDirect provides a rich user experience similar to using FileMaker Pro. It is 
ideal for working with teams located in remote offices to easily share information. Use 
FileMaker WebDirect to securely collect information like status updates, surveys, 
feedback forms, and more from geographically dispersed colleagues and associates.
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However, there are functionality differences between FileMaker Pro and FileMaker 
WebDirect that make it better suited as a complementary client rather than a 
replacement client in many situations. 

While FileMaker WebDirect is not blocked from running on Mobile devices, such as 
Android, the initial version has not been optimized for touch devices, primarily in the 
areas of touch-appropriate application UI. The performance on mobile devices will not 
be as good as a desktop due to the differences in resources such as CPU and memory.

Comparison
For a feature by feature comparison, please read our FileMaker WebDirect Guide: 
https://fmhelp.filemaker.com/docs/13/en/fm13_webdirect_guide.pdf
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Real-World Use Cases
FileMaker solutions are used to streamline a wide range of functions including: project 
management, asset management, invoicing and billing, catalog creation, customer 
relationship management (CRM), patient records management, film and video 
production, sales and advertising management, and customer service. 

Custom solutions created for an organization’s particular needs often involve forms, are 
data-driven, incorporate workflow and business rules, are shared by teams, and 
integrate with existing business systems. There are many real-world examples of how 
people use FileMaker solutions showcased on the FileMaker website at: 
http://www.filemaker.com/solutions/customers/

A few examples are highlighted below:

FileMaker Go in College Admission and Recruiting
Recruiters for Berklee College of Music, in Massachusetts, use a custom iPad solution 
to keep track of thousands of applicants and link to previously taped recordings of their 
performances. The Admissions staff reviews the information on iPad devices and on 
Mac computers. The system also incorporates data such as student ID numbers from a 
legacy student information system, and online applications and transcripts from a SQL 
database.

"FileMaker Go has become the core element that has helped us meet the demands of 
auditioning students with different musical and cultural backgrounds from 83 different 
countries and all 50 states," says Damien Bracken, Dean of Admissions. "I doubt we 
could continually succeed in identifying, assessing, and recruiting talent on the level and 
scale we have without FileMaker and FileMaker Go."

Tracking Inventory and Sales with FileMaker Go
The Vienna Benetton Mega Store simplified inventory management and point of sales 
information access by implementing a FileMaker solution. 

Before using FileMaker Pro, employees took every garment from the hanger and 
captured its data with a bar code scanner connected to a computer. Then they put the 
scanner aside and reached for a camera. Each product and every color variation had to 
be photographed and each picture stored manually on the computer. The employees 
filed each picture with its order number in Benetton’s merchandise management 
system. It was time-consuming and complicated.
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Christian Glöck, Benetton’s IT system administrator, realized that the iPad could be the 
solution Benetton needed thanks to the built-in camera and portability. With a 
customized FileMaker solution and iPads, the staff quickly photographs each item and 
scans its bar code, matching the bar-coded info to each image. This enables their co-
workers to later track the inventory, see what’s in stock, follow the paperless trail, and 
move that inventory off the sales floor and into customers’ hands.

Streamlining Work Orders with a FileMaker Solution
The Austin Convention Center in Texas created an iPad work-order solution that enables 
maintenance and technical services teams to spend more time on the show floor with 
customers and less time walking to and from the service desk. This solution connects 
workers on the floor to dispatchers located in the back office.

Previously, work orders were based solely on faxes and paper. The orders were keyed 
into the system, printed out, and placed in a binder with diagrams and other paperwork 
to start deployment or fulfill changes. Since implementing their FileMaker solution, the 
needs of the customers are documented immediately and workers are notified much 
faster than by fax or paper.

Providing Medical Documentation via FileMaker Go
Henry Schein Dental is one of the largest worldwide providers of healthcare products 
and services to dentists, doctors, and veterinarians. Sales consultants are armed with a 
custom sales literature solution created in FileMaker Pro and running on FileMaker Go 
for iPad. The solution lets them search through thumbnails, pull up pertinent literature, 
order a PDF or print version, and hand over personalized, "just-in-time" sales materials 
on the spot. 

For those who do not yet have an iPad, Henry Schein Dental uses the FileMaker API for 
PHP to deliver the same custom sales literature solution to sales consultants using a 
web browser on their desktop and laptops. As a result, speed of customer 
communication and knowledge of the available sales tools have improved significantly.

On the back-end, FileMaker Server tracks quantities of sales materials to determine 
exactly what needs to be printed, saving potentially tens of thousands of dollars 
previously wasted on overstocked, never-used brochures. Jon Baucom, Director of 
Marketing, and others on the marketing team can use FileMaker Pro on Windows and 
Mac computers to generate reports automatically and to chart inventory levels and 
popularity of specific pieces to continually improve and streamline the production 
process.
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Getting Started Tour
It is recommended that you review the Getting Started Tour built into FileMaker Pro 
and FileMaker Go prior to proceeding with the rest of the FileMaker Training Series: 
Basics.

While the Getting Started Tour cover foundational information about FileMaker Pro and 
FileMaker Go, the FileMaker Training Series: Basic will cover those topics and and many 
others in much more depth. 

You can access the Getting Started Tour in FileMaker Pro, upon opening it the first 
time or through the Quick Start Screen, found in the Help menu (shown in Figure 4).

FIGURE 4
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In the Getting Started Tour in FileMaker Go for iPad, you learn:

• How to use different data types on an iPad or iPhone

• That Camera, Audio, and Signature are unique to Container Fields on the iPad and 
iPhone

• That Photo, Music, and Files presumes the content is available on your device

• How to find, sort, or export data from an iPad or iPhone

You can access the Getting Started Tour in FileMaker Go, upon opening it the first time 
or by tapping on Getting Started in the file list screen, as shown in Figure 5.

FIGURE 5
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Review Questions
1. Describe two real-world use cases of a FileMaker solution.

2. What is the recommended way to share a FileMaker solution with multiple users?

3. Explain the software and hardware you need to design and build a FileMaker 
solution.

4. When do you need to purchase concurrent connections?

5. Describe two methods by which FileMaker Go can access a FileMaker solution.
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Answers
1. Berklee School of Music uses FileMaker Go on iPads to streamline recruiting for 

applications around the world. The Austin Convention Center replaced paper work 
orders with FileMaker on iPads. A Benetton Mega Store simplified inventory 
management and point of sales information. Additional use cases include client 
management, project tracking, event registrations, field research, and student 
information.

2. The best way to share a FileMaker database with multiple users is by hosting the 
file on FileMaker Server.

3. In order to design and build a FileMaker solution, you need FileMaker Pro or 
FileMaker Pro Advanced running on a Mac or Windows computer.

4. You need to purchase concurrent connections for FileMaker Server when you have 
users accessing your solution from an iPad, iPhone or web browser.

5. FileMaker Go can access FileMaker solutions that are stored locally on an iOS 
device, or it can access hosted solutions over Wi-Fi or a cellular network 
connection.
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Lesson 2

Using Starter Solutions

Time: This lesson takes approximately 20 minutes 
to complete.



Objectives

After this lesson, you will be able to:

• Determine when a Starter Solution best fits your needs

• Understand why Starter Solutions are useful for desktop and mobile 
development

• Create a file that’s accessible on your iOS device through FileMaker Go

There are three primary methods for creating a solution: beginning with a Starter 
Solution and modifying it to meet your needs, importing data from another source, and 
creating a solution from scratch. 

This lesson will explain how to start by using a Starter Solution.

FileMaker Pro comes with 16 built-in Starter Solutions that are professionally-designed 
templates customized for managing tasks on iPad, iPhone, desktop and the web. You 
will be able to get started managing contacts, assets, content, invoices, and more in 
just minutes. Plus, you can easily modify the Starter Solutions for your own unique 
needs.
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Choose a Starter Solution
Starter Solutions are fully built FileMaker solutions that allow users to manage many 
different types of information. They are also easily customizable by adding fields, 
rearranging layouts, and even copying or importing elements from a different Starter 
Solution.

To use a Starter Solution, simply go to the Quick Start Screen (in the Help menu), then 
choose Use a Starter Solution. Select a solution, save it to your desktop, then explore 
the template by entering data.

The list below summarizes the features, required skill level, and the data that can be 
stored for each of the Starter Solutions. Open and explore each of them to become 
acquainted with what each solution does—and how it works.

Assets - Beginner

Tracks office assets and other depreciable items. Fields include: asset category, serial 
number, and purchase date. Calculates depreciation using the straight-line method.

Contacts - Beginner

Manages complete contact information for all your business relationships, including 
multiple addresses, phone numbers, email address, and more.

Content Management - Beginner

Tracks different media files and relevant categorical and status information, as well as 
details about their revision history.

Expense Reports - Intermediate

Tracks and reports reimbursable expenses.

Inventory - Intermediate

Tracks inventory items, including category, value, and more. Also tracks stock 
transactions and company information.
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Meetings - Intermediate

Monitors meeting minutes and summaries, as well as action items and responsible 
parties.

Personnel - Intermediate

Manages employee data such as hire date, salary, manager, time off and date of next 
review. Integrates the information with the Expense Report template for more detailed 
information on every employee.

Projects - Intermediate

Manages project descriptions, a history of active and completed tasks, and all 
personnel associated with an assignment.

Research Notes - Intermediate

Compiles and organizes all research notes in one location. It also helps track web 
search notes.

Resource Scheduling - Intermediate

Manages the scheduling and commitment of resources. A resource can be a speaker, 
conference room, or projector.

Time Billing - Intermediate

Calculates hours worked, hours billed, and the hourly rate for each employee on a 
weekly basis. Provides a way to track billing by customer.

Estimates - Advanced

Features: Manages data for customer estimates, such as products, terms, discounts, 
tax rates, and more—and keeps track of how the information relates to both relevant 
customers and products. Easily prints estimates
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Event Management - Advanced

Tracks event details including tasks, agenda, invitees/guests, contributors, gifts, and 
thank you notes.

Invoices - Advanced

Similar to the Estimates template, but with data targeted toward invoicing needs. 
Manages contacts, products, and invoicing. Great for small businesses.

Tasks - Advanced

Tracks tasks and their owners for any project, and instantly access details through 
each step.

29



Quick Mobile Development
If you want to create a FileMaker solution, many of the Starter Solutions provide an 
excellent framework for mobile use with FileMaker Go. All solutions are designed to 
detect how it is being accessed, then display an optimized view of data. Personnel 
Records, Research Notes, and Time Billing all have specific iPad layouts—and the other 
solutions have layouts that are designed for both iPad and iPhone.

Complete the following activity to learn some of the features of Starter Solutions that 
are optimized for iOS.

Activity 2.1: Exploring the Event Management Starter Solution
1. Open FileMaker Pro 13. The Quick Start Screen opens automatically—if it does 

not, select Quick Start Screen in the Help menu.

2. Choose Use a Starter Solution..., then choose Event Management.

3. Name the file "Event Management.fmp12” and save it to your desktop. After the 
file is saved, the solution opens to the Event Details layout.

4. Enter some test data of your own in the record that the solution created.

5. Add a few tasks, as pictured in Figure 6.

6. Close the file.
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FIGURE 6

7. Email the Event Management file to an email account that you can access on an 
iPad or iPhone.

8. On an iPad or iPhone with the FileMaker Go 13 app installed, tap the Event 
Management file attached to your email, then choose Open in FileMaker Go.

9. Tap the name of the event to see the Event Details layout, which should look like 
Figure 7.
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FIGURE 7

Several features of Starter Solutions are optimized for iOS:

• Device detection - Solutions are automatically set to the layouts that are optimized 
for each platform—desktop, iPad, or iPhone—without any further development.

• Space optimization - The optimized layouts are designed to save space and 
present the most relevant data. For example, the Event Overview layout shown in 
Figure 8 uses a list view for Tasks rather than a portal because users can see and 
manipulate more information in less space.

• Easy data entry - All the layout elements are the optimal size for data entry based 
on the device.
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FIGURE 8
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Review Questions
1. If you need to create a solution that keeps track of customers, products, and 

purchase orders, which Starter Solution should you use?

2. Which template would you use to build an iPad solution for a scientist who needs 
to collect lab notes?

3. What are the main differences between the Starter Solutions for Assets and 
Inventory?

4. Describe one possible use of the Starter Solution for Content Management.

5. What are three features that make Starter Solutions so helpful to mobile 
development?

6. Which Starter Solution helps track an employee’s time off?
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Answers
1. The Starter Solution for Invoices works best in this situation—to keep track of 

customers, products, and purchase orders.

2. Research Notes is ideal for this solution.

3. The Assets solution tracks office assets and other depreciable items. Its fields 
include asset category, serial number, and purchase date. It calculates 
depreciation using the straight-line method. The Inventory solution tracks product 
inventory items, including category, value, and more.

4. The Content Management solution tracks different media files and relevant 
information such as categories and status, as well as details about their revision 
history. It can be used for images, documents, videos, and much more.

5. The three features that make Starter Solutions helpful to mobile development are 
solutions that show a layout that’s optimized for each device, they’re built with 
layout features that optimize space and viewing on mobile devices, and they were 
designed for easy data entry with Multi-Touch gestures.

6. Personnel Records helps track an employee’s time off.
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Lesson 3

Viewing and Working with Data

Time: This lesson takes approximately 20 minutes 
to complete.

Lesson File: Contacts.fmp12



Objectives

After this lesson, you will be able to:

• Describe the function of a layout, and give examples of when different 
layouts might be needed

• List and describe when to use the four modes within layouts

• Compare and contrast the three layout views

• Describe two methods to navigate between records

• Create a new record

• Add, modify, save and delete data

Now that you have learned about Starter Solutions, we will use the Contacts Starter 
Solution with data in it to help you navigate, organize and work with data in a FileMaker 
solution. In this lesson, you will learn about layouts, records, different modes to work 
with your solution, and different ways to view and edit your data.

Here is what you learned from the Getting Started Tour.

• Getting Started > Record & Fields

A database file is organized into tables. Tables store records. Each record is a 
collection of information stored in fields.

Fields hold data including text, numbers, dates, images, and more.

• Getting Started > Viewing Data

FileMaker Pro displays fields on layouts.

Databases can have layouts for viewing forms or reports, printing labels, entering 
data on iOS devices and more.

Browse, Layout, Find and Preview are layout modes.

You can display layouts in List View, Table View or Form View. These are layout 
views.
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Layouts
Layouts provide the user interface for a FileMaker solution and organize how you see 
information. Whether you’re entering data or printing reports, the layout handles how 
the data is displayed. Layouts do not store data. You can create many layouts to see the 
same record—or set of records—in different ways. For comprehensive instruction about 
layouts, refer to Lesson 9.

Switching Layouts
To move to different layouts, use the Layout pop-up menus shown in Figures 9 and 10.

FIGURE 9
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FIGURE 10

When you switch to a different layout, you might see the same records or a different set 
of records depending on the context of the layout. For example, you might start with a 
Contact Details layout that shows each contact as a form, then switch to a Contacts 
List layout that shows the same found set of contacts as a list. Then, you might switch 
to a Company List layout that shows a found set of company records as a list.
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Modes Within Layouts
You interact with a layout in one of four modes. In FileMaker Pro, the modes are: 
Browse mode, Find mode, Layout mode, and Preview mode. You can change the 
mode with a keyboard shortcut, through the View menu, or the pop-up menu at the 
bottom of the window as shown in Figure 11.

FIGURE 11

In FileMaker Go, only the Browse mode and Find mode are available.

Browse mode
You will use Browse mode to do most of your work, including all data entry and 
viewing. You can add, view, edit, sort, omit (hide), and delete records.

The keyboard shortcut is Command-B in OS X or Ctrl-B in Windows.

Find mode
You can search for records that match a set of criteria in Find mode. You enter search 
criteria, then perform the search, and FileMaker Pro returns all the matching records in 
Browse mode. You can then work with this subset (or found set) of records. The 
keyboard shortcut is Command-F in OS X or Ctrl-F in Windows.

In FileMaker Go, to enter Find mode, tap the magnifying glass button, then choose 
Enter Find Mode as shown in Figure 12.
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FIGURE 12

You’ll learn how to use Find commands in Lesson 4.

Layout mode
When you modify layouts to provide users with different interfaces to access data, you’ll 
use Layout mode. FileMaker Pro uses Layout mode to show information both on a 
screen and in printed materials. This mode is not available in FileMaker Go.

The keyboard shortcut is Command-L in OS X or Ctrl-L in Windows.

Preview mode
To see how data looks before you print it, use Preview mode. This mode is especially 
helpful to view layouts with multiple columns, and reports with summaries. This mode is 
not available in FileMaker Go.

The keyboard shortcut is Command-U in OS X or Ctrl-U in Windows.
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Views Within Layouts
You can display a layout using one of three views. In FileMaker Pro, select the view from 
the View menu or from the Status Toolbar shown in Figure 13. In FileMaker Go, you 
can access the View As options from the Layout pop up menu in the lower left of the 
screen shown in Figure 14.

FIGURE 13

FIGURE 14

View as Form
To view and modify records individually, use Form view. Though you might have 
multiple records, you see only one record at a time in Form view.
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View as List
You see a scrollable list of records in List view. Scroll up and down to browse through 
records. The number of records you can see at one time depends on the structure of 
the layout. The current record is marked with a thin, black bar at the left of the record, 
and is the record that will be affected by commands such as Delete Record or 
Duplicate Record. When you are in List view, you can click or tap a record to make it 
the current record.

View as Table
People who use spreadsheets will discover that Table view looks very familiar. Data 
fields are represented as columns, and the records are represented as rows. Table view 
can be quite powerful because you have easy access to resize, reorder sort, and hide 
columns, and to view summary data.
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Records
You can move between records many ways. In FileMaker Pro, the status toolbar 
includes buttons for Next record and Previous record in a Book icon, as well as a 
slider shown in Figure 15. In FileMaker Go, you move between records using the slider 
shown in Figure 16 or with a two finger swipe in FileMaker Go 13. The Status Toolbar 
shows the current record number, the number of records in the set if applicable, and the 
sort status.

FIGURE 15

FIGURE 16

Activity 3.1 – Moving Between Layouts and Records
Practice moving between layouts and records using the methods that were described in 
this lesson:

1. Open the Contacts.fmp12 file in FileMaker Pro. The file will open to the Contact 
Details layout. Which view is shown?

2. Switch to the Desktop > Contacts layout using the Select Layout pop-up menu. 
Which view is shown?

3. Move three records ahead by clicking the Next button from the Status Toolbar. 
The destination record is Cynthia Butler.

4. Use the slider to go to the last record. The record should be for Steve Williams.

5. Use the scroll bar on the right side of the window to scroll to the top of the 
window. Notice that this action does not change the current record.
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Working With Data
When you use FileMaker Pro or FileMaker Go, you enter and interact with data in 
Browse mode.

Creating a New Record
When entering new data, you will first create a new record. In FileMaker Go, tap on the 
plus/minus button and tap Add New Record, as shown in Figure 17.

FIGURE 17

There are several ways to create a new record in FileMaker Pro. You can choose New 
Record from the Records menu, click the New Record button in the status toolbar as 
shown in Figure 18, or use the keyboard shortcut Command-N for OS X or Ctrl-N for 
Windows.

FIGURE 18
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Duplicating a Record
Duplicating a record can be an efficient way to create a new record. For example, if two 
people live at the same address, you can duplicate one person’s record and change 
only the details about the second person that are different. In an Event Management 
database, you can duplicate a record to create new records for events that are similar to 
each other, again changing only the details that differ.

To duplicate a record in FileMaker Go, tap on the plus/minus button and tap Duplicate 
Record as shown in Figure 19.

FIGURE 19

In FileMaker Pro, choose Duplicate Record from the Records menu or use the 
keyboard shortcut Command-D for OS X or Ctrl-D for Windows.
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Modifying Data
To enter data in a field in FileMaker Go, first tap in the field to make it active. Then use 
the Next and Previous buttons above the keyboard to move through the fields. In 
FileMaker Pro, click in a field or use the Tab key to move from field to field. Shift-Tab 
will move you backwards through the tab order.

Some fields may require different types of data entry. Many fields are formatted as edit 
boxes that allow you to enter data. Other fields will have pull-down menus, radio 
buttons, or checkboxes to select data. If a field is set as a date, time, or timestamp, you 
must enter a valid value.

Saving Data
When you enter data, the record is not saved, or committed, to the file until you take 
one of four actions:

• Change modes

• Change to a different record

• Change to a different layout

• Click or tap outside of all fields in the record (such as the background)

While, by default, changes you make to the data are automatically saved as you work, 
you can configure any layout to ask you to confirm record changes. In the General tab 
of the Layout Setup dialog shown in Figure 20 uncheck Save record changes 
automatically.

FIGURE 20
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If you have entered data in a record but have not yet committed it, you can revert the 
record back to the previously saved version.

When a record is not committed or locked in a multi-user environment, other users will 
not be able to modify the record until it has been committed. This automatic record 
locking preserves the integrity of the data by allowing only one user at a time to modify 
a record.

Deleting Data
Deleting a record in a FileMaker file is permanent. You cannot retrieve the data or undo 
the delete. To delete a record in FileMaker Go, tap the plus/minus button and tap Delete 
Record as shown in Figure 21.

FIGURE 21
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In FileMaker Pro, choose Delete Record from the Records menu, click the Delete 
Record button in the status toolbar, or use the keyboard shortcut Command-E for OS 
X or Ctrl-E for Windows.

In both FileMaker Pro and FileMaker Go, a dialog will ask you to confirm that you want 
to delete the record permanently.

Activity 3.2 – Creating New Records and Entering Data in 
FileMaker Pro
Practice creating new records and editing data in the Contacts starter solution.

1. Open Contacts.fmp12 and navigate to the Contact Detail layout.

2. Click the New Record button in the Status Toolbar. 

3. Fill out the new record with your contact information. Use the Tab key on the 
keyboard to navigate between fields.

4. When finished, click on the background of the layout where there are no objects. 
This will save the record. 

5. Delete your record by either click Delete Record in the Status Toolbar, or going 
to Records > Delete Record.

6. When asked to Permanently delete this ENTIRE record, click Delete.
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Review Questions
1. If you want to view a database like a spreadsheet, which view should you use?

2. When you’re browsing records in FileMaker Go, how can you move to the next 
record?

3. Which mode would you use to create a new record?

4. What are three of the four ways that you can save, or commit, a record?

5. How many users can modify a record at once?

6. Can deleting a record be undone?

50



Answers
1. The Table view shows the fields in columns and records in rows.

2. You tap the Next and Previous buttons to move between records or use a two 
finger swipe motion in FileMaker Go 13.

3. Use Browse mode to create a new record.

4. You can commit a record by changing layout, changing mode, changing record, or 
clicking or tapping outside all the fields of the current record.

5. Only one user can modify a record at once. Another user cannot modify the record 
until it has been committed.

6. No, deleting a record cannot be undone. The only way to recover the data would 
be to import the record from a backup of the database.
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Lesson 4

Finding and Sorting Records

Time: This lesson takes approximately 20 minutes 
to complete.

Lesson File: Contacts.fmp12



Objectives

After this lesson, you will be able to:

• Perform complex finds

• Extend and constrain found sets

• Make use of operators in your search requests

• Sort records

In the Getting Started Tour in FileMaker Pro, you learned how to perform basic 
searches using Find mode and how to perform quick searches using Quick Find. 

In this lesson, you will learn how to do more complex searches.

Here is what you learned from the Getting Started Tour.

• Getting Started > Finding Data

Use Find mode to search for records containing data stored in specific fields.

Use Quick Find to search across all fields on the current layout.

• Getting Started > Sorting Records

Sorting changes the order in which data is displayed.

You can sort data by multiple fields to group records.
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Specifying Search Criteria
When performing a simple search, FileMaker by default performs a "words begin with" 
search. This means that unless you search for exact matches, the field you are 
searching can contain:

• Longer words that begin with the values you specify

• Other words, in addition to the ones you specify

• Values in any order

For example, if you were to enter "mary" as the search criteria in a First Name field, your 
found set will include records for Mary, Mary Beth, Maryann, and Rose-Mary. But it will 
not find Rosemary or Jomary. Note that searches are not case sensitive (unless the 
indexing of the field is set to Unicode). 

The quickest way to search is to use the contextual shortcut menu to find matching 
data in a particular field. Right-click (or Control-click) a field that has the criteria you 
want. Choose Find Matching Records from the shortcut menu and FileMaker Pro finds 
records that have the same value in that given field.

Activity 4.1: Contextual shortcut for Finds
Find records matching the Company field for Dave Andrews.

1. In the Contacts file, go to the Contact Details layout.

2. Click Show All in the Status Toolbar, and navigate back to the first record.

3. Right-click in the Company field containing “West Side Antiques” and a pop-up 
menu appears.

4. Choose Find Matching Records. Your new found set includes all contacts that 
work for "West Side Antiques".

Performing AND or OR Searches
It is helpful at times to find data based on multiple fields. For example, finding all 
contacts that are Artists at Rankin Studios. This can be done in Find mode by entering 
your criteria in each field. After you perform the search, the results will match ALL the 
criteria that you entered. This is known as an AND search.
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On the other hand, what if you want to search for people who are Family or Friends? 
Rather than using multiple fields in a single search request, as you do when you perform 
an AND search, you can use multiple requests to perform an OR search.

Activity 4.2: Performing AND and OR searches
Perform an AND find for Contacts who are Artists at Rankin Studios. Then perform an 
OR find for Contacts who work at Kristi's Auctions or Williams Design Studio.

1. On the Contact Details layout, enter Find mode by choosing Find mode from the 
View menu.

2. Enter "Rankin Studios" into the Company field and "Artist" into the Job Title 
field. Entering search terms into two or more fields within the same find request 
creates an AND find.

3. Click Perform Find in the toolbar. All artists at Rankin Studios are returned.

4. Enter Find Mode again. This time we’ll create an “or” find by using multiple find 
requests.

5. Enter "Kristi's Auctions" into the Company field.

6. Click New Request in the status toolbar, and enter “Williams Design Studio” into 
the Company field.

7. Click Perform Find in the toolbar. 

8. Switch to the Contacts layout in the upper left. Notice all contacts in the found set 
work for Kristi's Auctions or Williams Design Studio.
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Extending and Constraining a Found Set
When performing a new search, FileMaker Pro searches all records and replaces your 
previous found set with a new found set. This is handy for most searches, but 
occasionally it is necessary to search within a found set, or to add records to your 
current found set. FileMaker allows users to either extend or constrain the existing 
found set with the following menu options:

• Extend Found Set: When you extend your found set, the omitted records are 
searched. Any omitted records that match the search criteria are added to your 
current found set.

• Constrain Found Set: When you constrain your found set, the search is limited to 
only the records in the current found set. Any records in the current found set that 
match the search criteria are returned.

Both the Extend Found Set and the Constrain Found Set options are in the contextual 
shortcut menu and the Requests menu.

Activity 4.3: Extending a Found Set
Perform a find for Contacts in the Friend group, then extend your found set to include 
Contacts in the Personal group.

1. On the Contact Details layout, enter Find mode.

2. Enter "Friend" in the Group field and perform the find. Notice the found set is 13 
records.

3. Go back into Find mode and enter "Personal" in the Group field.

4. Choose Requests > Extend Found Set. Your results include 26 contacts in both 
the Personal and Friend groups.

Activity 4.4: Constraining a Found Set
Perform a find for Contacts that work at West Side Antiques, then constrain your found 
set to only Assistants.

1. On the Contact Details layout, enter Find mode.

2. Enter "West Side Antiques" in the Company field and perform the find. Your 
results should include 6 records.
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3. Go back into Find mode and enter "Assistant" in the Job Title field.

4. Choose Requests > Constrain Found Set. You’ll see all contacts who are 
Assistants at West Side Antiques.

57



Using Operators in Search Criteria
An operator is a symbol or instruction that gives you more flexibility with your search 
criteria. For example, you can search a date range by entering two dates separated by 
the range operator (…).

When you enter Find mode, you will see that the Status Toolbar contains a drop-down 
menu. You can either choose the operator from the drop-down menu or you can enter it 
with the keyboard.

Operators are helpful for finding ranges of dates, times, and numbers, using “wildcards” 
to find partial matches in text searches, or changing FileMaker’s default “words begin 
with” behavior. Two very popular searches involve finding records where a field is empty 
or finding records with a field contains data.

Activity 4.5: Finding Empty Fields
Perform a search to find Contacts without a mobile phone number.

1. On the Contact Details, enter Find mode.

2. Enter "=" in the Mobile field.

3. Click Perform Find in the toolbar, or press the Enter key. The found set should 
contain 35 contacts without a mobile phone number.

Activity 4.6: Finding Non-Empty Fields
Perform a search to find Contacts with a personal phone number.

1. On the Contact Details, enter Find mode.

2. Enter "*" in the Personal phone field. This tells the database to find records where 
the field content is equal to not empty.

3. Click Perform Find in the toolbar, or press the Enter key. The found set should 
contain 37 contacts with a personal phone number.
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Finding Strings of Characters in a Field
Another way of using the asterisk (*) operator is to modify the "word begins with" 
behavior of Find mode. For example, you can find all values in a First Name field that 
end with "ary" by using *ary as your search criteria. This search would find people such 
as Mary, Rosemary, and Gary, but it would not find Aryanna.

If you want to find values in a First Name field that include "ary" anywhere in the value, 
your search criteria should be *ary*. This will find any values that start with, include, or 
end with "ary," so it would also find people such as Mary, Karyn, and also Aryanna.

Finding a Range of Data
When you work with numbers, dates, and times, you may want to search for data in 
ranges. For example, suppose you want to find all orders shipped from the start of 
January to the end of March in 2014, or all items over $500. To perform such searches, 
use operators like greater than (>), less than (<), or an ellipsis (…). 

Find mode has four operators to help find data before or after a specific value: greater 
than (>), greater than or equal to (≥), less than (<), and less than or equal to (≤). In Find 
mode, place any of these operators before the value. For example, to find all assets 
over $500, place “>500” in the cost field.

The ellipsis (…) allows users to find data between two values. For example, in order to 
find dates between the beginning of January and the end of March, enter 1/1/2014…
3/31/2014 in the Ship Date field. You can select the ellipsis from the operators pop-up 
menu (Figure 22), type three periods, or type Option–; (Option–semicolon) on a OS X.
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FIGURE 22

Finding Exact Data
While the default "word begins with" logic is usually helpful in finding data quickly, it can 
return more records than you might want. For example, searching for "North" in a 
Region field results in values like "North," "Northwest," and "Northeast."

• Exact field match: To be more specific in a search, use two equal signs (==) to 
obtain an exact field match. Entering "==North" in the Region field shows only those 
records that have the exact value "North".

• Exact word match: One equal sign (=) performs an exact word match. For example, 
"=North" results in records containing "North" and "North Pole," but not "Northeast."
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Sorting Records
Whether you are looking at all records or a found set, it is usually helpful to sort your 
data. For example, you could sort contacts alphabetically by Last Name, or sort 
invoices in ascending date order by their Ship Date. By default, records display in the 
order in which they were created in the table. 

To open the Sort Records dialog (Figure 23), click Sort in the Status Toolbar, or use 
the keyboard shortcut Command-S (OS-X) or Ctrl-S (Windows).

FIGURE 23

Choosing Sort Fields
In the Sort Records dialog box, the left side contains a list of all the fields on the 
current layout. By clicking Current Layout (…), you can choose to sort on other fields in 
the solution. 

To add a field to the sort order, double-click the field name in the list, or select the field 
and click Move. You can sort by one field or multiple fields. In Figure 24, the data sorts 
by Last ascending, then First ascending. 
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FIGURE 24

Setting Sort Order
The icon to the right of the field in the Sort Order box indicates how the data will sort. 
To specify ascending or descending sort order for a field, select the field in the Sort 
Order pane and choose Ascending order or Descending order using the radio 
buttons in the middle of the dialog. You can also click the Unsort button at the bottom 
of the dialog, which returns the records to creation order.
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Review Questions
1. Describe two ways that you can perform AND searches.

2. How can you find all records with an empty field?

3. What operators allow finding of ranges of dates, times, and numbers?

4. In what order do records show if they are not sorted?
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Answers
1. Two ways to perform AND searches:

• Type criteria into multiple fields in one single search request.

• Perform a simple search, and then narrow the found set by using Constrain 
Found Set through the application menu or the contextual shortcut menu.

2. To find all records with an empty field, use the = sign in Find mode in the field.

3. The operators for finding ranges of dates, times, and numbers are: Greater than 
(>), Greater than or equal to (≥), Less than (<), Less than or equal to (≤), and Ellipsis 
(…).

4. Records will show in the order they were created when they are not sorted.
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Lesson 5
User-Centered Design

Time: This lesson takes approximately 20 minutes 
to complete.



Objectives

After this lesson, you will be able to:

• Identify the steps of the design process

• Describe your user’s goal as a one-sentence problem statement

• Understand the needs of the fictitious company, Equipment Providers, Inc., 
used in the rest of the lessons.

User-centered design is an established methodology for product interface design that 
involves the eventual users of the solution in each stage of the design process. It forces 
product developers to focus on the user—and to step away from the computer.

The aim of user-centered design is to build solutions that focus on users’ goals, not 
features. By focusing on goals, you will ensure that your solution is solving the right 
problems, therefore making your users more confident and successful.
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What is User-Centered Design?
We’re surrounded by software. We repeatedly check our iPhones for messages. We use 
self-checkout lines in the supermarket, monitor the GPS systems in our cars, cruise the 
Netflix queues on our televisions. More and more, we’re facing screens—and not 
computer screens.

Mobile computing has arrived, and it’s changed our expectations of software. Today, it’s 
no longer good enough for a software product or application to work—it has to work 
well. The developers that are making a difference in our world are taking great 
technologies and shaping them with user-centered design.

Three Basic Principles
The basic principles of user-centered design are:

1. Observe users – their goals, behaviors, mental models

2. Make technology serve users – not the other way around

3. Test with users – give them a natural goal, then sit back and watch

If you are doing user-centered design correctly, you will be repeating this process over 
and over again until you identify what really meets the users’ expectations. 

Think Goals Not Features
Start by understanding what the user wants to achieve, not the features you think the 
user needs.

Why? Because goals are much more descriptive than features. For example, consider a 
Porsche and a riding lawnmower. They have the same features including an internal 
combustion engine, four wheels and rubber tires, a transmission, and a steering wheel. 
But when described in terms of goals, the lawnmower cuts grass evenly while the driver 
is seated comfortably. This is a big difference from a Porsche!

Think Differently
Building a solution begins with the user-centered design process, not with development 
in FileMaker Pro. By stepping away from the computer, you free yourself to think and 
act differently during the design process.
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You will need some imagination. Do some "whiteboarding" with users, Borrow design 
patterns from other places, like the Starter Solutions or your favorite apps. And 
remember, more isn’t necessarily better. 

You will need some knowledge. A solid understanding of what is possible with the 
FileMaker Platform will lead to better ideas.

And you will need an "I can do it" attitude. Don’t be intimidated by user-centered 
design. Adopt one, two or a few of these practices and grow from there.
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Basic Principles
Observe users - their goals, behaviors, mental models
Taking the time to understand your audience and their needs up front is the first step in 
designing a truly useful and usable solution that your users will love. Put yourself in their 
shoes and truly immerse yourself in their job roles. 

Describe your user’s goal as a one-sentence problem statement:

Design a [form of solution]
For [user type]
To [human activity]
With [level of support]

For example, for a hospital, the statement might be:

Design a [kiosk application]
For [urgent care patients]
To [sign in]
With [speed]

Yes, your users will likely have more than one goal. Write down all your users’ goals and 
their problem statements. You may have users with different goals and you will need to 
prioritize which problems are the most important. However, don’t try to solve every 
problem at once. Solve a simple problem first, then, gradually add complexity.

Sketches, whiteboards, wireframes and flowcharts can be helpful in communicating 
what you have learned. Allow yourself to be creative and observe your users.

Make technology serve users - not the other way around
Where will it be used? In an office, in the field, in bright daylight, at night, in a car, near 
water, etc.? 

What posture will the users have during use? Standing, sitting, one-handed, two-
handed? How precise will the users be able to be during use?

Will they be using Windows, Mac, iPad, iPhone, or a web browser? If using an iPad or 
iPhone, which orientation will it be used in most? Landscape, portrait, or both?
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The FileMaker Platform gives you many tools to simplify the user experience. But like 
any tool, it can be used in a million different ways. It is your design choices that will 
determine if you frustrate users or delight them.

Test with users - give them a natural goal, then sit back and 
watch
Prototypes may start as flowcharts and whiteboards, but will evolve into something your 
users can actually use. Developing in FileMaker Pro lends itself well to this step since 
development is very iterative, allowing you to make changes at any time in the process.

During this time, allow your ideas and solutions to evolve. Ask for feedback from users 
and have a discussion on what the solution lacks and offers for the users. During this 
whole process, you may revisit previous steps. The design process involves multiple 
iterations in order to create a successful solution.
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Equipment Providers, Inc.
Throughout the rest of the FileMaker Training Series: Basics, you will be learning 
FileMaker by building a solution for a fictitious company, Equipment Providers, Inc.. The 
company rents office equipment to a number of customers. Now we will start by going 
through the user-centered design process steps.

Observe users - their goals, behaviors, mental models
The Equipment Provider Inc. management team has noticed that many assets are not 
being tracked properly. While employees track data in an Excel spreadsheet, they are 
not consistent. Occasionally, employees will write asset details on a sticky note and ask 
the company’s administrative assistant to type the data into the spreadsheets, but the 
notes get lost among other paper or accidentally thrown away. 

After reviewing the data, there are numerous spelling and consistency errors in the data. 
For example, the Asset category column shows mismatched data like "Office Furniture" 
and "Furn.: Office", making it hard to properly group and sort data.

When it comes to the Customer information, most of the existing information is out of 
date. Employees depend on their own address books instead of the spreadsheet, which 
limits access by other employees. Additionally, Customers are required to sign a paper 
copy of the Asset information to confirm that they received the asset. These paper 
copies are rarely placed in the filing system in a timely manner—usually 3 to 4 weeks 
after being signed. In other words, the current spreadsheets in place are either missing 
data or outdated.

This fictitious example has the following primary one-sentence problem statement:

Design a [customer asset tracking solution]
For [the operations team]
To [know which customers have which assets]
With [speed and accuracy]

In addition, the following elements are relevant:

• Currently the Customer and Asset data is stored in Excel spreadsheets.

• It will be important to know when an asset was purchased, when it was given to the 
customer, and how much the asset cost.
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• When the customer receives the asset, a signature is required. Currently, a form is 
printed out with asset details and the customer signs the form. However, all 
employees have an iOS device provided by the company, so the best plan would be 
to leverage signing out assets from an iPhone or iPad

• Users want the ability to add notes to a given asset. Notes can be anything from 
details about the asset (color, size, etc.) to damage information when the Customer 
returned the asset. It would be best if the user could type information into a Notes 
field.

• It is imperative to know how long a customer has leased each asset.

• It will be important to know the total cost of a Customer’s Assets.

• Users, except for the Admin account, should not be able to modify Customer 
information. All users can edit Asset data.

• Users cannot delete any Customers or Assets.

• Pushing the data to the web would be useful so that Customers can see a list of 
Assets they have.

• It would be nice to have a report that provides all assets by customer and the total 
cost per customer.

Based on the relevant points observed about the Equipment Provider Inc. scenario, 
there may be additional one-sentence problem statements. Here are a few others to 
consider:

Design an [iPad workflow]
For [a delivery worker]
To [get a customer’s signature]
With [security and reliability]

Design a [method of inputing data]
For [an operations team member]
To [take notes about an asset]
With [speed and portability]

Design a [report]
For [an administrative assistant]
To [view assets for customers and their total cost]
With [update to date information]
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Make technology serve users - not the other way around
Employees deliver and install equipment onsite. Most of the sites are office buildings. A 
signature is collected from the customer to verify that the equipment was properly 
delivered and installed. For these reasons, it would be easier for these employees to 
access the solution from an iPhone or iPad rather than from a computer.

The employees have a lot of deliveries and installations during the day so they need a 
solution that requires very little time to view and record information. 

As you continue through the training, you will build a solution for Equipment Providers, 
Inc. while learning about data, user interface, solution logic, reporting, integration, 
security, and deployment.
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Review Questions
1. What are the three basic principles of user-centered design?

2. What is the template for a one-sentence problem statement?

3. What is the primary one-sentence problem statement for the employees of the 
fictitious company, Equipment Providers, Inc.?
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Answers
1. First, observe users taking note of their goals, behaviors, and mental modes. Next, 

make the technology serve users, not the other way around. Lastly, test with users 
by giving the natural goals, and watch their behaviors.

2. Design a [form of solution]
For [user type]
To [human activity]
With [level of support]

3. Design a customer asset tracking solution
For Operations
To know which customers have which assets
With speed and accuracy
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Lesson 6
Importing Data

Time: This lesson takes approximately 20 minutes 
to complete.

Lesson File: Customers.xlsx, Assets.xlsx



Objectives

After this lesson, you will be able to:

• Identify common file formats that can be converted by FileMaker Pro 13

• Convert a supported file format into a FileMaker solution

• Convert an Excel workbook with multiple worksheets into a single FileMaker 
solution

There are three primary methods for creating a solution: beginning with a Starter 
Solution and modifying it to meet your needs, importing data from another source, and 
creating a solution from scratch. 

In this lesson, we’ll begin to build the solution for Equipment Providers, Inc. by 
importing data from two spreadsheets.

In the Getting Started Tour you learned:

• Getting Started > Importing Records

You can import data from another FileMaker Pro file or from another application, 
such as Microsoft Excel. 

When you import, you can add new records to your database or update data in 
existing fields.
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Converting an Existing File
FileMaker Pro can import many different file formats. This is useful because the 
conversion process automatically creates tables, fields, and records, reducing the 
number of steps required to get started using FileMaker Pro. It also removes the need to 
manually input information that you already have. File formats that will convert directly 
into FileMaker files include:

• Microsoft Excel files (.xls or .xlsx)

• Tab-separated text files (.tab or .txt)

• Comma-separated text files (.csv or .txt)

• Merge files (.mer)

• XML files (.xml)

• dBASE files (.dbf)

• Bento files (.bentodb)

Other file types will need to be converted to one of the supported file formats before 
they can be converted to .fmp12. For example, the records from a Microsoft Access 
database (.mdb) can be exported as Microsoft Excel files. Three of the most common 
file formats converted into FileMaker files are Excel, comma-separated values, and tab-
separated values.

You may need to clean up your spreadsheets to make the transition to FileMaker Pro 
easier. For example, include a header row (which FileMaker Pro will interpret as field 
names), remove any blank rows, and remove any subtotal or total rows (since FileMaker 
Pro allows you to create necessary fields to show summarized data).
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Converting Excel Files
An Excel spreadsheet is one of the files most frequently imported file types. 

FileMaker retains Excel data types such as text, numbers, dates, etc. when data is 
imported. If a column of data in the original spreadsheet is a mix of data types, 
FileMaker Pro will import that column as text.

In the case of Equipment Providers, Inc., you import two sets of data, Customers and 
Assets.

Similar to a spreadsheet with multiple worksheets, a FileMaker solution can store 
different categories of information in tables, such as Customers and Assets.

Activity 6.1: Importing a spreadsheet to create a new
FileMaker file
You will create a FileMaker file called Equipment Rentals.fmp12 using the spreadsheet 
data you have. When you bring the data into FileMaker Pro, tables are automatically 
created and the data is populated into fields.

1. Click and drag the Customers.xlsx file over the FileMaker Pro application icon in 
your computer’s toolbar.

2. In the First Row Option dialog, select Field Names and click OK. This tells 
FileMaker Pro that the first row contains column headers that should be used as 
field names in the new database.

3. Name the file Equipment Rentals.fmp12 and save the file on your desktop.

4. Go to File > Manage > Database... and go to the Tables tab. The import process 
named the first table the same name as the file. Since the data in this table is 
customer data, select the Equipment Rentals table, type “Customers” in the Table 
Name area, and click Change.

5. Click OK to exit the Manage Database dialog.

6. Your file has been created and FileMaker Pro will show you the data on a Layout 
named Layout #2, shown in Table view.

Note: You can also import data files from the Quick Start Screen by using the Convert 
an Existing File option.
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Activity 6.2: Importing a spreadsheet into an existing 
FileMaker File
Your users will also want to view Asset data in this solution. Import the Assets.xlsx 
spreadsheet into the Equipment Rentals file.

1. Choose File > Import Records > File.... Navigate to the Assets.xlsx file and click 
Open. The second set of data must be imported into a new table.

2. Click on the drop-down labeled Target on the upper right of the Import Field 
Mapping dialog and choose New Table ("Assets").

3. Check the box for Don’t import first record (contains field names). Your screen 
should look like Figure 25.

FIGURE 25
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4. Click Import. After the import, an Import Summary window appears showing 29 
records imported. Click OK.

At this point, two tables of data exist in the Equipment Rentals file.
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Review Questions
1. What are the three primary methods of creating a new solution?

2. List three common file formats that can be converted directly into a FileMaker Pro 
file.

3. If a file format cannot be converted directly into a FileMaker Pro file, what must you 
do to get the data into a FileMaker Pro file?
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Answers
1. Solutions are created by either beginning with a Starter Solution, importing data 

from another source, or creating a solution from scratch.

2. Three of the most common file formats converted into FileMaker files are Excel, 
comma-separated values, and tab-separated values. FileMaker Pro also supports 
the conversion of dBASE, merge, Bento, and XML files.

3. File formats not directly supported by FileMaker Pro have to first be converted into 
a supported format. It may be necessary to request that the data be supplied in a 
supported format.
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Lesson 7
Creating Fields and Tables

Time: This lesson takes approximately 20 minutes 
to complete.

Files: Equipment Rentals.fmp12



Objectives

After this lesson, you will be able to:

• Create tables from the Manage Database Dialog

• Create fields from the Field Picker in Layout mode

• Create fields from the Manage Database Dialog

In this lesson, you will learn how to create fields from the Field Picker. You will also learn 
how to create fields from the Manage Database Dialog. FileMaker Pro gives you these 
different options to make it quick and easy to add fields while you create your solution.

In the Getting Started Tour in FileMaker Pro, you learned how to add existing fields to 
your layout from the Field Picker.

• Creating Solutions > Tables

Databases contain tables that represent categories of data, such as Assets or 
People.

Tables are made up of fields that store data in these categories.
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Create New Tables
As you expand your solution, you will add more tables and fields to your database. 
There may be additional data, that didn’t previously exist, that you want to store in the 
FileMaker file.

To review and define tables, fields, and relationships in your solution, you can use the 
Manage Database dialog, shown in Figure 26. You can access it by choosing File > 
Manage > Database.... You can also use the keyboard shortcut Command-Shift-D 
(OS X) or Ctrl-Shift-D (Windows).

FIGURE 26

As you can see in Figure 26, the two sets of data that we imported into FileMaker Pro 
from spreadsheets are represented by tables.
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You can create new tables for additional data on the Tables tab simply by typing the 
name of the new table in the Table Name area and clicking on the Create button. Once 
the table is created, you can begin to add fields.

When naming tables or fields, it is advised that you use only alphanumeric characters 
(or underscores). If you try to use other characters, you may see the dialog shown in 
Figure 27.

FIGURE 27
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Field Types
With FileMaker Pro, you can create six types of fields to store data: text, number, date, 
time, timestamp, and container. Two other field types, calculation and summary, are 
used to automate and aggregate data.

Choosing Field Types
Each field in a FileMaker file must have a specific data type. Choosing an appropriate 
data type for a field allows FileMaker Pro to decide how best to store and retrieve that 
data. Although FileMaker Pro is flexible about the kind of data that can be stored in 
fields of specific types, it is best to choose appropriate field types based on your file 
design. For example, field type affects the sort order. FileMaker Pro applies different 
rules for sorting text, number, and date fields.

The list below provides an overview of FileMaker field types.

Field Type: Text

Data Type: Any data that can be stored as text and does not need more specific 
handling. Numbers or dates can be stored, but in a Text field, they are addressed as 
plain text, for example in a text field numbers sort as 1, 10, 2, instead of in numerical 
order as 1, 2, 10).

Notes: Can store approximately 2 GB of Unicode values

Field Type: Number

Data Type: Any data that need to be treated as a number, such as data that must be 
sorted in numerical order or used in a mathematical calculation.

Text strings are displayed but ignored in most database operations; if you need to enter 
mixed data, use a text field instead.

Notes: Can store 400 digits to either side of the decimal point
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Field Type: Date

Data Type: Any date between 1/1/0001 and 12/31/4000 (assuming m/d/y date 
formatting).

If you enter a date in an unacceptable format, an error dialog results.

Notes: Dates are interpreted as the number of days elapsed from 1/1/0001

Field Type: Time

Data Type: Either a duration or a specific time of day (in a 24-hour period).

If you enter non-numeric data into a time field, an error dialog results.

Notes: Times are interpreted as the number of seconds from midnight

Field Type: Timestamp

Data Type: A combination of date and time, separated by a space.

Timestamp fields have the same date-range restrictions as date fields.

Notes: Timestamps are interpreted as the number of seconds since midnight on 
1/1/0001

Field Type: Container

Data Type: Any type of binary data (data that cannot be meaningfully represented as 
text). Can include images, signatures, PDFs, video or audio files, QuickTime files, or 
binary files of any type.

Notes: Can store approximately 4 GB of binary data

Fields Used to Automate and Aggregate Data
There are two field types that derive their value by referencing data in other fields:

Field Type: Calculation

Data Type: Stores or continuously reevaluates any data based on a formula.

For example, if a record has a Quantity field and a Unit Price field, a calculation field 
called Line Total can calculate the total by multiplying quantity by unit price.
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Field Type: Summary

Data Type: A field type that aggregates values (total for a group, average for a group) 
across a found set of records, and possibly for each subgroup within a sorted found set.
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Create New Fields from the Field Picker
The Field Picker is a new feature in FileMaker Pro 13 and FileMaker Pro 13 Advanced. 
While in Layout mode, the Field Picker provides a nice visual display of all your 
existing fields in an inspector-like interface right next to your layout. To add fields to 
your layout, simply select, drag and drop a field onto your layout in the desired location. 
You can also use the Field Picker to create new fields and drag them directly onto your 
layout. 

Let’s create a new field within our solution. Remember that Equipment Providers Inc. 
wanted to provide a way for customers to sign a form verifying that Equipment was 
delivered?

For the Equipment Rentals file, you will need to add a container field so that customers 
can add their signature when they receive equipment.

Container fields in FileMaker solutions can store and enable interaction with these types 
of files:

• Images

• Video or audio files

• QuickTime files—movie, sound, or other QuickTime-capable files

• Files of any type—Word, Excel, PDF, and more

Activity 7.1: Creating a New Container Field from the Field Picker
In the Equipment Rentals file, users need to gather customers signatures when an asset 
is delivered. Use the Field Picker to create a signature field for the Asset table.

1. Navigate to the Assets layout and enter Layout mode.

2. Click the Field Picker button in the status toolbar to display the Field Picker, 
shown in Figure 28.
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FIGURE 28

3. Click the  icon labeled New Field.

4. Type "Signature" as the field name and select Container as the field type. You 
have now successfully created a Container field to store Customer signatures.

5. Drag the new Signature field out onto the layout and place it on the right side of 
the layout, and click out of the Field Picker.
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Create New Fields from the Manage Database 
Dialog
Creating fields in the Field Picker is incredibly easy, but when many changes are 
needed across multiple tables, it can be quicker to do the work in the Manage 
Database Dialog.

Activity 7.2: Creating a New Text Field from the Manage 
Database Dialog
For the Equipment Rentals file, it will be helpful to have a notes field so that employees 
can add notes when they deliver and pickup equipment. Create a notes field within the 
Manage Database dialog.

1. In the Manage Database dialog, click on the Fields tab. 

2. Choose Assets from the Table drop-down.

3. Type Notes in the Field Name area.

4. Choose Text in the Type drop-down and click Create.

5. Click OK to close the Manage Database dialog.
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Review Questions
1. Name 4 different types of fields you can create in FileMaker Pro.

2. What types of information can be stored in Container fields?

3. If you are editing a layout, what is the easiest way to create a new field?

4. If you are in the Manage Database dialog, how do you create a new field?
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Answers
1. Text, numbers, date, time, timestamp, container, calculation, summary are the field 

types you can create in FileMaker Pro.

2. Container fields store binary data like images, signatures, PDFs, video or audio 
files, QuickTime files, or other files.

3. The Field Picker is the easiest way to create a new field while editing a layout.

4. While on the Fields tab, type the name of the new field in the Field Name box, 
select a field type, and click Create.
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Lesson 8
Relationships

Time: This lesson takes approximately 20 minutes 
to complete.

Lesson File: Equipment Rentals.fmp12



Objectives

After this lesson, you will be able to:

• Understand one-to-many and many-to-many relationships

• Understand the usage of primary and foreign keys

• Create relationships between tables

• Understand table occurrences

FileMaker is a relational database management system, which provides a way to relate 
two or more sets of data in order to reduce double data entry and help improve the 
consistency in your data.

The Getting Started Tour in FileMaker Pro introduced the basic concept of 
relationships. In this lesson, you will learn about the different types of relationships and 
what is needed to create a relationship.

Here is what you learned from the Getting Started Tour.

• Creating Solutions > Relationships

Relationships connect data stored in different tables in a database.

You can enter data once, then view and use that data in related tables or files.

A portal is a layout object that displays data from related tables.
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Relationships
Relationships Types
Now that you have learned how to create tables and fields, you can now link together 
related information from those different tables. A relational database reduces the need 
to enter the same data multiple times or in multiple places. 

For example, in the Equipment Rentals file, customer information is stored once in the 
Customer table. When an Asset is linked to a Customer, the user can view the related 
information from the Customer record. This saves the user from having to enter that 
Customer information again. Also if the user updates the customer’s contact 
information, the new information will be available for all Assets.

The most common relationship types in a relational database are one-to-many and 
many-to-many.

One-to-many
This is the most common type of relationship. Consider the Equipment Rentals 
solution:

• Each Customer may potentially have many Assets.

• Each Asset is associated with only one Customer.

The relationship between Customers and Assets is a one-to-many relationship. 

When identifying the relationships between entities, there are some notations that are 
commonly used. As shown in Figure 29, a line is used to connect boxes representing 
the two entities, with a crow’s foot at the end that represents the "many" side of the 
relationship.
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FIGURE 29

These relationships can be described as follows:

• One car may have many oil changes over time; each oil change is performed on 
one car.

• One customer may place many orders over time; each order is placed by a 
single customer.

Many-to-many relationships
Now consider a solution that tracks movies and actors. What is the relationship 
between actors and movies?

• One actor may act in many movies over time.

• One movie has roles for many actors.

In this case, the relationship is many-to-many, as shown in Figure 30.
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FIGURE 30

Identifying Relationship Types
Whether a relationship is one-to-many or many-to-many is not always obvious. The 
correct answer may depend on the specifics of the situation you are trying to capture. 
Suppose you have a solution that tracks paintings and artists. You may assume that the 
relationship between artist and painting is one-to-many:

• One artist may paint many paintings.

• Each painting is painted by only one artist.

The first point seems obvious. What about the second? If the solution tracks projects 
like community murals, the second point may not be correct—many artists could 
contribute to one painting. If you are tracking class paintings, then you may need to 
think about paintings started by a teacher and finished by his or her student. The 
relationship may be better modeled as many-to-many.
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Using Primary and Foreign Keys to Relate 
Tables
When relating tables, it is important to uniquely identify each record. By having a unique 
identifier, you will be able to create relationships between tables. Also, it is useful to be 
able to reference any given record by a unique identifier when troubleshooting a 
database. 

For example, invoices from service providers have an Invoice Number and this is often 
the unique identifier. This provides both the customer and the service provider with a 
way to easily reference the same invoice.

Primary Keys

The unique identifier in FileMaker is called a primary key. It is recommended that you 
create a primary key in every table in order to uniquely identify any record. A primary 
key should follow these rules:

• be unique for every record in the table

• never changes

• never be empty

It is good practice to allow FileMaker Pro to create the primary key values automatically, 
ensuring that the three rules above are followed. Note that the data you imported into 
the Customers and Assets tables already contained primary keys: Customer ID and 
Asset ID, respectively. The primary key values were manually entered in the 
spreadsheet but FileMaker Pro can automatically assign these values for future 
Customers and Assets.

Activity 8.1: Adding an Auto-Enter Field Option to Primary Keys
You will modify the existing primary key fields to auto-enter a serial number for future 
new records.

1. Open the Manage Database dialog and click on the Fields tab. Make sure the 
Customers table is selected.

2. Double click on the Customer ID field to bring up the Field Options dialog. 
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3. On the Auto-Enter tab, activate the Serial number option (by entering a 
checkmark in the checkbox next to Serial number) as well as Prohibit 
modification of value during data entry (at the very bottom) to prevent users 
from modifying the primary key. 

4. Our largest Customer ID is currently 112 for Williams Design Studio. Change the 
next value to 113, as shown in Figure 31 to make sure the values in this field are 
always unique. Click OK.

FIGURE 31

5. Change the list of fields to the Assets table. 

6. Double click on the Asset ID field. Repeat step 3 and 4 above, but change the 
next value to 1984.

Foreign Keys
While a primary key is an attribute that allows you to uniquely identify a Customer, how 
can it be used to link a Customer to one or more Assets? For the relationship to work, a 
field must be created in the Asset table. You can assign a Customer to an Asset by 
entering the primary key value from the Customer record into an Asset record, providing 
a link between the two tables. The name of this type of field is a foreign key.
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When thinking about a one-to-many relationship, the "many" side will always contains 
the foreign key. In the Equipment Rentals file, the Asset table requires a customer 
foreign key.

The foreign key, Customer ID has already been created in the Asset table.
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Creating Relationships 
The Relationships tab of the Manage Database dialog contains the Relationships 
Graph. It provides a way to graphically represent and specify relationships among the 
tables in your database.

Each box on the graph is called a table occurrence (TO). Think of a TO as an alias or 
shortcut to a table. To check the source table for a TO, hover your mouse over the small 
arrow left of the name of the TO, as shown in Figure 32. Because you can create 
multiple TOs based on the same table, you can create many different relationships 
between any two tables.

FIGURE 32

Creating Relationships
With primary keys and foreign keys created in the Equipment Rentals file, the database 
is properly setup to create relationships between tables.

Activity 8.2: Creating a Relationship
You will set up a relationship between the Customers and Assets tables. 

1. Navigate to the Relationships tab of the Manage Database dialog. 

2. Click and drag from the Customer ID field in Customers to the Customer ID field 
in Assets. Your relationships graph will look like Figure 33.
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FIGURE 33

3. Click OK to close the Manage Database dialog.

A relationship has now been created between the primary key in the Customers table 
and the corresponding foreign key in the Assets table. This will allow you to associate 
any number of Assets with a given Customer.
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Review Questions
1. What are the two most common types of relationships?

2. What is the relationship between the following:

• Actors and Movies

• Songs and Concerts
• Aircrafts and Inspections

• Race and Swimmer
3. What field should you create in every table of your FileMaker solution?
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Answers
1. One-to-many and many-to-many are the most common relationships.

2. The relationships are:

• Many-to-many

• Many-to-many
• One-to-many

• Many-to-many
3. You should always add a primary key field to every table.
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Lesson 9
Layouts

Time: This lesson takes approximately 20 minutes 
to complete.

File: Equipment Rentals.fmp12



Objectives

After this lesson, you will be able to:

• Create layouts for specific devices

• Add fields to layouts

• Apply styles and themes to layouts

Layouts provide the canvas for creating your user interface. Whether you will present 
forms, lists, reports, charts, or complex workflows, layouts are the way to present 
information and actions for your users. 

A layout consists of:

• A layout area 

• Objects: Fields, Web Viewer, Tab Controls, etc.

• A Theme and Styles

Here is what you learned from the Getting Started Tour. 

• Creating Solutions > Themes & Styles

Themes provide coordinated colors, fonts, and other styling for layouts.

Some themes are specially designed for iOS devices.
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Creating Layouts
A layout organizes how you see information in a FileMaker solution. Whether you’re 
entering data or printing reports, the layout handles how the data is displayed. Layouts 
do not store data. You can create many layouts to see the same record—or set of 
records—in different ways.

Each layout is tied to a table occurrence, which is considered the layout’s "context". 
Each layout is associated with one table occurrence on the relationships graph.

In order to create, view, and modify layouts, you need to be in Layout mode. In addition 
to the standard ways of switching modes—the View menu and the pop-up menu in the 
bottom left of the document window—FileMaker also has an Edit Layout button at the 
bottom right of the Status Toolbar when viewing a layout in Form or List view, shown in 
Figure 34.

FIGURE 34

Activity 9.1: Creating a New Layout
You will create a layout in Equipment Rental.fmp12 to display data from the Customers 
table for use with FileMaker Pro on a desktop or laptop computer.

1. Choose View > Layout Mode, or use the keyboard shortcut Command-L (OS X) 
or Ctrl-L (Windows) to enter Layout mode. 

2. Choose Layout > New Layout/Report, or click the New Layout/Report button in 
the Status Toolbar, or use the keyboard shortcut Command-N (OS X) or Ctrl-N 
(Windows). 

3. Choose Customers on the Show records from: drop-down list. 

4. Change the layout name to "Customer Details".

5. Click on Computer since this layout will be viewed using FileMaker Pro on a 
desktop computer. 
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6. Choose Form so that the layout will show one record at a time, shown in Figure 
35. Click Finish.

FIGURE 35

Layout Parts
FileMaker layouts are divided into layout parts. The three most used parts are the 
header, body and footer. These different sections of the layout control how and where 
data, text, and graphics are displayed. For example, text placed in a header part prints 
at the top of each page, while text placed in the body part appears once for each 
record.

When you create a new layout, it automatically has one or more parts depending on the 
choices you made in the New Layout/Report dialog. Each layout must have at least 
one part. In Layout mode, a gray horizontal line marks the division between layout 
parts. You can resize a part by dragging the line up or down. You will learn more about 
Layout Parts in the Lesson 16: Reporting.
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Adding Fields to a Layout
When you create a new layout by clicking on New Layout/Report, the layout will not 
have any fields, which means no data will be visible. Depending on the needs of your 
users and how they plan on using the current layout, it may contain as few or as many 
fields as is necessary.

Activity 9.2: Adding Fields to a Layout Using the Field Picker
Equipment Providers, Inc. needs a layout that will include all of the customer 
information. You will use the Field Picker to add fields to the Customer Details layout.

1. Click the Field Picker button in the Status Toolbar, or use the keyboard shortcut 
Command-K (OS X) or Ctrl-K (Windows). The Field Picker will appear, shown in 
Figure 36.

FIGURE 36

112



2. Click on the Customer ID field. Hold down the Shift key and click on the last field, 
Phone. All fields will now be highlighted.

3. Drag the selected fields to the layout. This will add the fields along with a field 
label, based on the field name, as shown in Figure 37.

4. Click out of the Field Picker, save your layout, enter Browse mode, and flip 
through a few records. 

FIGURE 37

113



Selecting Fields from Field Picker
If you want to select multiple fields that are grouped together in the Field Picker:

• Click on the first field

• Hold down the Shift key

• Click on the last field

If you want to select multiple fields that are not grouped together:

• Hold down the Command (OS X) or Control (Windows) key

• Click on each field
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Layout Themes and Styles
Themes
Themes help create a visually attractive user interface by providing consistent styles for 
buttons, fields, background, and other objects on a layout. Themes apply predefined 
fonts, sizes, colors, padding, and other styling to your layout objects.

When you select a new theme for a layout, all existing layout objects adopt the new 
theme styles. Object positions, however, remain fixed, so it may be necessary to adjust 
some of the objects manually depending on the theme selected. It is recommended that 
you experiment with several themes before you choose one. 

Note: A theme called Enlightened is the default theme for any new file you create or a 
file that has been created from an Excel spreadsheet.

Activity 9.3: Changing the Theme
You will choose a theme that will be used throughout all the layouts for the Equipment 
Rentals file.

1. From the Customer Details layout, enter Layout mode. 

2. Choose Layouts > Change Theme... or use the Change Theme  button in 
the layout bar. A popup will appear showing you all the themes available, shown in 
Figure 38.

FIGURE 38

3. Select the Vibrant theme and click OK.
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All objects on the layout will change to the defaults of the Vibrant theme. 

FileMaker also contains a set of themes with the suffix “Touch”. These themes are 
specifically designed for layouts built for iOS devices. Each of these themes use 
recommendations from Apple’s iOS Human Interface Guidelines by making fonts larger 
and buttons bigger for easier use on iOS devices. When developing a solution for iOS, it 
is recommended that you use a Touch theme.

Styles
Each theme comes with a set of styles for each object type. Styles allow you to easily 
define and apply consistent formatting to objects on a single layout or across all 
layouts. All formatting options found in the Inspector can be used when defining a 
style. You can even use an image for the background of an object and save that as part 
of the style. 

Styles are part of the overall layout theme. Within a theme, each type of layout object 
may have many available styles. Each object on a layout is assigned to a style. Upon 
assigning a style to an object, it is formatted according to the style. 

You can edit existing styles as well as create new styles. Changes to existing styles can 
be applied to all objects with that style on the current layout or to all objects with that 
style on every layout that uses the same layout theme. 

Utilizing consistent themes and styles throughout your solution can make updating the 
look and feel of your solution quick and easy. You can access styles by going to the 
Styles tab on the Inspector while in Layout mode, as shown in Figure 39.

FIGURE 39
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Creating More Layouts
It is common to have different views of the same data. For example, while the Customer 
Detail is helpful in the Equipment Rentals file, the solution can benefit from having a 
Customer List. With the Customer List (List view), a user can scroll and see essential 
data about multiple Customers at once. With Customer Details (Form view), the user 
can see each customer's full details one at a time. 

Activity 9.4: Creating a List View Layout
1. Enter Layout mode and create a new layout.

2. Base the layout on the Customers table and call it Customer List.

3. Select Computer and List, then click Finish.

4. Click the Change Theme  button, select the Vibrant theme and click OK. 

5. Open the Field Picker and change the Drag Options to place fields horizontally 
with labels above the field like Figure 40.

FIGURE 40

6. Add the following fields to the layout with the Field Picker:

• Customer ID

• Company
• Website

• State

You can select multiple fields by holding Command (OS X) or Control (Windows) 
while clicking. Place the objects on the layout so that the labels are in the Header 
and the fields are in the Body.

117



7. Select the labels and change the font color to white by clicking on View > 

Formatting Bar or by clicking the  button in the layout bar.

8. Go to Browse mode (View > Browse Mode) and your layout should look like 
Figure 41.

FIGURE 41

With the two Customer layouts you created, Customer List and Customer Detail, 
users will be able to see a little bit of data about multiple customers or a lot of data 
about one specific customer.
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Review Questions
1. In which mode can you create layouts?

2. What are the device options when creating a new layout?

3. What tool allows you to quickly add multiple fields to a layout?

4. Which themes are better suited for iOS devices?
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Answers
1. All layouts are created in Layout Mode.

2. Computer, touch, and printer.

3. The Field Picker.

4. Any theme with the suffix “Touch”.
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Lesson 10
Layout Design Tools

Time: This lesson takes approximately 20 minutes 
to complete.

File: Equipment Rentals.fmp12



Objectives

After this lesson, you will be able to:

• Style objects with the Inspector

• Select, move, and resize objects

• Turn on Grids and Guides

• Create layouts built and sized for iOS devices

Once layouts are created, the next step is to place objects on the layout and style them 
appropriately. It is important to make interfaces that are consistent and simple for users 
to understand. Grids, Guides and Stencils are some of the tools available in FileMaker 
Pro to aid developers in creating the best experience possible for their users.

Here is what you learned from the Getting Started Tour.

• Creating Solutions > Layout Objects

Layout objects are elements placed on a layout. They enable users to view and 
interact with data.

You can select, move, resize, delete, copy, format, name and change objects.

• Creating Solutions > Layouts

FileMaker Pro includes tools to create beautiful layouts for easy data entry and 
analysis.

You can customize layouts by editing objects, positioning and arranging them, 
resizing them, and making other changes to their appearance.
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Status Toolbar and Inspector
In Layout mode, the Status Toolbar provides quick and easy access to many of the 
tools you use while working with layouts. These tools, shown in Figure 42, allow you to 
create new layout objects and apply colors and styles to existing objects.

FIGURE 42

The bottom row of the Status Toolbar is called the Formatting Bar. If it is not 
displayed, you can activate it by clicking on View > Formatting Bar or by clicking the 

 button in the layout bar.

There are standard text and drawing tools that you may find familiar. For example, to 
add a box to a layout, click the Rectangle tool, then click and drag to draw the box on 
the layout.

Inspector
The Inspector is the object control center where you can view and modify the settings 
for all objects on a layout. Each of the four panes of the Inspector—Position, Styles, 
Appearance, and Data—focuses on a different aspect of formatting (Figure 43).
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FIGURE 43

You can open and close Inspectors by using any of these methods:

• Choose View > Inspector (or View > New Inspector for multiple Inspectors)

• Click the  button in the layout bar.

• Use the keyboard shortcut Command-I (OS X) or Ctrl-I (Windows).

You can quickly switch to an Inspector tab by using the keyboard shortcuts 
Command-1, 2, 3, and 4.
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Layout Resizing
FileMaker Pro provides tools that allow faster, cleaner creation of a solution. Just like 
themes, which offer a consistent look and feel to a FileMaker solution, certain features 
of FileMaker Pro help you build a professional-looking database.

Selecting, Resizing and Moving Objects
To select a layout object, click on the object (for example, any field in the Equipment 
Rental file is considered an object). You will see small squares, called handles, that 
represent the corners and sides of the object. 

You can change the size of an object by dragging any of the handles. If multiple objects 
are selected while dragging the handles, the objects will all resize with respect to each 
other. This is very useful, especially when resizing a group of fields and other layout 
objects.

You can move an object that you have selected by dragging any part of the object other 
than its handles. To move an object a small distance, select it, then use the arrow keys 
on the keyboard to move an object one point (pt) at a time.

Layout Width
To set the width of a layout, drag the dark gray line that represents the right edge of the 
visible layout area. This defines the area where objects will be seen in Browse mode. 
Any object placed outside of the layout’s defined width is treated as an invisible object 
in Browse mode.

Screen Stencils
When you are creating solutions for different platforms and screen sizes, FileMaker Pro 
contains a set of screen stencils that you can use for accurate layout sizing. You can 
easily optimize layouts for iOS devices by using a stencil.

Each stencil shows the borders of the iPad or iPhone in both portrait and landscape 
orientation to aid in design. The stencils can be turned on or off in the formatting bar. 
You can turn on multiple stencils at the same time for cross-platform solutions or for 
multi-orientation devices such as the iPhone and iPad. Figure 44 shows a layout with 
one 4" portrait iPhone stencil turned on.
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FIGURE 44

To toggle the screen stencils, click the stencil icon on the right side of the status toolbar, 
shown in Figure 45. Clicking the arrow will provide you with a list of stencils that can be 
turned on or off, including different desktop resolutions, iPhone, iPad, and a custom 
size.

FIGURE 45
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Guides and Grids
Dynamic Guides
Guides help you align objects on a layout during your solution creation process. The 
two types of guides are dynamic guides and ruler guides.

Dynamic guides enable you to quickly define the position and size of objects based on 
other objects on your layout. As you move or resize an object, blue lines appear to 
indicate that the object you are changing is aligned to other objects.

Figure 46 shows the dynamic guides that appear as you move or resize an object on a 
layout.

FIGURE 46

Ruler Guides

In order to position objects on your layout more precisely, turn on the page rulers 
(choose View > Rulers). To create a ruler guide, click either the top ruler for a horizontal 
guide or the left ruler for a vertical guide, and drag the guide onto the layout. Figure 47 
shows a layout with two horizontal guides and three vertical guides.
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FIGURE 47

The Snap to Guide feature automatically aligns objects to the nearest guide when you 
move objects within a few points of the guide. (activate by choosing View > Guides > 
Snap to Guide.) 

Object Grid

In order to display a grid on your layout, turn on the Object Grid, which will show major 
and minor grid lines. Enable the Object Grid using either of these methods:

• Choose the View > Grid > Show Grid.

• Find it at the bottom of the Position pane on the Inspector.

When you check Snap To Grid, moving or resizing objects on your layout will cause 
them to snap to the major and minor grid lines. You can change the increments at the 
bottom of the Position pane on the Inspector.
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Using Layout Design Tools
During the Equipment Providers, Inc. discovery phase, you learned that Assets may be 
given to a Customer during an on-site visit, and the user needs to collect a signature 
confirming that the Asset was received. Since FileMaker Go serves as a great tool for 
mobility and capturing signatures, you will need to create an Asset layout for the iPhone 
and iPad.

Activity 10.1: Creating an iPad Layout
You will create a Form view layout that is appropriately sized for the iPad. 

1. Click on New Layout/Report.

2. Base the layout on the Assets table and name it "Asset Details - iPad". 

3. Choose Touch Device. Then choose iPad/iPad mini.

4. Choose Form. Click Finish.

5. Change the theme to Vibrant Touch. 

6. Turn on the iPad (portrait) screen stencil.

7. Set the Drag Options to vertical fields in the Field Picker with the labels on the 
left.

8. Add the following fields to the layout with the Field Picker, within the stencil. In 
Browse Mode, your layout should look like Figure 48:

• Asset ID
• Customer ID

• Item
• Model

• Serial Number
• In Service Date

• Purchase Date
• Cost

• Signature
• Notes
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FIGURE 48

Activity 10.2: Creating an iPhone Layout
You will create a layout that will be sized for a 4" iPhone screen.

1. Create a Form view layout based on the Asset table called "Asset Details - 
iPhone". Choose Touch Device. Then choose iPhone 4-inch. Choose Form and 
then click Finish.

2. Change the theme to Vibrant Touch.

3. Turn off the iPad screen stencils and turn on the iPhone 4-inch (portrait) screen 
stencil. 

4. In the Field Picker, set the Drag Options to vertically align fields with the label on 
top like Figure 49.

FIGURE 49
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5. With less screen space on an iPhone, you may not want to include all the fields 
from the iPad layout. Add the following fields to the layout with the Field Picker:

• Item

• Serial Number
• Signature

6. If necessary, extend the layout's height by dragging down the bottom edge of the 
Body. In Browse mode, your layout should look like Figure 50.

FIGURE 50
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Creating iOS Layouts
When creating a new layout for an iOS device, FileMaker Pro will create a script 
that is attached to the layout as a script trigger. This means that automation has 
been added to the layout based on user interaction with it. The script locks the 
zoom feature on the device, which prevents the layout from zooming in if a user 
accidentally double-taps on it.
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Review Questions
1. What is the name of the object control center where you can view and modify the 

settings for any object?

2. What do Screen Stencils show?

3. What is the difference between Dynamic Guides and Ruler Guides?
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Answers
1. The Inspector is the object control center where you can view and modify the 

settings for any object.

2. Screen stencils show the borders of a chosen device for the size specified.

3. Dynamic guides automatically display blue lines that help you align and size 
objects in relation to other objects on the layout. When designing a layout, you 
have control in setting ruler guides where you need them to align objects 
consistently on one or many layouts.
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Lesson 11
Special Layout Objects

Time: This lesson takes approximately 20 minutes 
to complete.
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Objectives

After this lesson, you will be able to:

•  Create a Portal

•  Create a Tab Control

•  Create a Panel Control

•  Create a Popover

•  Create a Web Viewer

From the Status Toolbar, you can add basic items such as text, shapes, fields, and a 
variety of special layout objects, as shown in Figure 51. These objects perform specific 
and special functions on a layout that you will learn about in this lesson.

FIGURE 51

136



Portal
A portal is a tool for displaying a set of related records. In a one-to-many relationship, a 
portal shows the "many" side of a relationship.

In Activity 8.2, you created a relationship from Assets to Customers, where the Asset's 
Customer ID field matches the Customer's Customer ID field.

Activity 11.1: Viewing Related Data via a Portal
You will create a portal on the Customer Details layout that will show related Assets.

1. Navigate to the Customer Details layout and enter Layout mode. Turn off any 
screen stencils used in previous activities.

2. Portals are created by either clicking on the Portal tool  in the Status Toolbar 
or using the Insert > Portal menu item. For this step, choose Insert > Portal.

3. In the Portal Setup window, click on the Show related records from: drop-down 
and choose Assets as the related table (Figure 52).

FIGURE 52

4. Activate Show vertical scroll bar to enable the user to scroll down if the list of 
related data extends beyond the viewable area. Click OK.
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5. A window titled Add Fields to Portal will appear. Double-click on the following 
fields and click OK:

• Category
• Item

• Serial Number
• Purchase Date

• Cost
6. A portal with related fields–in the first row–will appear on your layout. Move the 

portal to the right side of the screen.

7. Adjust the width of the portal and the related fields by making them bigger.

8. Unlike adding fields using the Field Picker, the Portal tool does not automatically 
create related field labels. Use the Text icon in the toolbar to manually add labels 
for each field.

9. Fields in portals can start to look busy. To reduce this visual clutter, select the 
fields, go to the Style tab in the Inspector, and choose the style called Minimal 
Edit Box.

10. Go to Browse mode and your layout should look similar to Figure 53.

FIGURE 53
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Earlier you created a relationship from Assets to Customers, where the Asset's 
Customer ID field matches the Customer's Customer ID field. In order to show data 
from a related record, change the Current Table drop-down in the Field Picker to the 
correct related table—in this case, Customers.

Activity 11.2: Adding Related Fields
You will add the Company field to the Asset Details - iPad layout from the related 
Customers table.

1. Navigate to the Asset Details - iPad layout.

2. Enter Layout mode.

3. Using the Field Picker, change the Current Table drop-down in the Field Picker 
to the related table Customers, and change the Drag Options to not include a 
label.

4. Drag the Company field onto the layout next to Customer ID so it looks like 
Figure 54.

5. Enter Browse mode and navigate between records to view the company name for 
each asset.
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FIGURE 54
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Tab Control
A user interface that includes tabs, is a popular design feature for many applications. 
When you select a tab, it can display a unique set of objects or data, which allows you 
to use the same section of layout real estate for multiple purposes.

The term tab control refers to the entire layout object, as shown in Figure 55. Each tab 
control can contain one or more individual tabs, called tab panels. The tab control is not 
a navigation tool; it is a layout organization tool used to selectively display different sets 
of fields (or related fields) from the same layout context.

FIGURE 55

Tab controls are placed on the layout using the Tab Control tool  in the Status 
Toolbar.You can modify the appearance of a tab control object in several ways. You can 
add, rename, remove, or reorder the panels in a tab control through the Tab Control 
Setup dialog (shown in Figure 56). Access the Tab Control Setup dialog by double-
clicking or right-clicking the tab object. The Tab Control Setup dialog also provides a 
way to define the default tab, the tab justification, and tab width.
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FIGURE 56

With the help of the Inspector, you can customize many aspects of your tab. Using the 
Appearance tab of the Inspector, you can specify the background fill, borders, and 
corner radius, as well as tab specific attributes for the hover state. However, all tabs 
must have the same text style attributes, such as font, color and size.

To place an object on a tab panel:

1. Enter Layout mode.

2. Select the tab panel.

3. Move the object so that it is entirely contained within the boundaries of the 
selected tab control.

If you need to move a tab control, simply drag the tab control object itself. All objects 
contained within all tabs will move.
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Slide Control
The slide control is a new type of layout object introduced in FileMaker Pro 13. It was 
inspired by the page control of the iOS interface. The springboard (or home screen) of 
an iPad, iPhone, and iPod touch is an example of an iOS page control.

Similar to the tab control, the term slide control refers to the entire layout object as 
shown in Figure 57. 

FIGURE 57

Each slide control can contain one or more slide panels. Because the two controls are 
related, the tab control and slide control are created using a single tool on the status 
toolbar. 

To add a slide control to a layout:

1. Click and hold the Tab Control  or Slide Control  tool and select Slide 
Control.

2. Click and drag on the layout to draw the boundaries of the new slide control.

After drawing the boundaries of the slide control, the Slide Control Setup dialog, 
shown in Figure 58, will appear. It can also be opened by double clicking the slide 
control object. The Slide Control Setup dialog includes settings for specifying the 
number of panels, whether or not FileMaker Go users can swipe to navigate between 
panels, whether or not navigation dots are displayed and specifying the size of the 
navigation dots.

Note that when the dots are not displayed, the developer must provide buttons or some 
other scripted way to navigate between slide panels.
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FIGURE 58
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Popover
Like the slide control, the popover button is a new type of layout object introduced in 
FileMaker Pro 13. A popover button expands to display a popover object that floats 
over the window, obscuring the content behind it. Figure 59 shows a popover button 
that has been clicked to reveal the popover object. The popover object is a panel in 
which you can display any type of layout object. Similar to a tab control or slide control, 
it has the same context as the layout.

FIGURE 59

Popover buttons are handy in situations where you might otherwise have opened a new 
window. Some examples of how a popover button can be useful include displaying:

• Detailed information about an object or data

• A portal containing a related set of data

• A web viewer used to render a map, dashboard, or aggregate information

• Help text to give the user instructions

• A navigation bar or navigation sub-menu

Similar to tab controls and slide controls, a single tool on the status toolbar is used for 
creating buttons and popover buttons. 
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To add a popover button to a layout: 

1. Click and hold the Button  or Popover Button  tool and select Popover 
Button. 

2. Click and drag on the layout to draw the boundaries of the popover button.

When a popover button is created, its popover object is automatically created. The 
Popover Setup dialog, shown in Figure 60, is also displayed. It provides options for 
specifying the popover title, the location of the popup object relative to the button, and 
configuring script triggers.

FIGURE 60

Once the Popover Setup dialog is closed, it can be displayed again by double-clicking 
the popover object or by right-clicking the popover object and selecting Popover 
Setup.
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Web Viewer
A web viewer is an object used to display web pages directly in a FileMaker layout. Web 
viewers have many practical uses in FileMaker solutions. For example, a web viewer 
can:

• Display a map website that contains directions to the address stored in a company 
record

• Calculate the URL for tracking a package based on data stored in a tracking number 
field

Other uses include embedding access to search engines, looking up stock quotes, and 
generating reports and graphs. The Web Viewer Setup dialog allows you to construct 
the URL that the web viewer uses to display a web page. The URL usually includes 
fields in the calculation, meaning that data from the current record can be used to 
dynamically search the web. 

Note: The user’s device or computer must be connected to the Internet in order for a 
web viewer to display an external web page.

Activity 11.3: Adding a Web Viewer
In this example, you will add a web viewer to the Customer Details layout that displays 
Google Maps search results for the customer’s address. Please note that you will need 
to be connected to the internet in order for the web viewer in this example to function 
properly.

1. Go to the Customer Details layout and go into Layout mode.

2. Select the Web Viewer tool (  icon) in the Status Toolbar. Define the area on 
the layout by drawing a box for the boundaries of the new web viewer. The Web 
Viewer Setup dialog will appear.

3. Choose Google Maps (US) in the Choose a Website box on the left hand side.

4. Click on the  button next to the Address box and select Specify Field Name...

5. Choose the Address field from the Customers table and click OK.
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6. Repeat steps 4 and 5 for the City, State, and Zip Code boxes, selecting the City, 
State, and Zip fields from the Customers table accordingly. The Web Viewer 
Setup dialog should look like Figure 61 when you are done.

FIGURE 61

7. Click OK on the Web Viewer Setup dialog, save the layout, and go into Browse 
mode. Your layout should look similar to Figure 62.
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FIGURE 62

Navigate through Customer records to test the web viewer. It should display Google 
Maps search results for the address of the current Customer record.

Note: You may need to make the web viewer, and possibly the layout, larger in order to 
view the contents of the Google Maps page.
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Review Questions
1. What are the five special layout objects?

2. A portal can be used to view which side of a relationship?

3. How do you add an object to a tab control?

4. What are some uses for popover buttons?

5. How can Web Viewers be dynamic?
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Answers
1. Portals, tab controls, slide panels, popovers, and web viewers are five special 

layout objects.

2. Portals are used to view the “many” side of a relationship.

3. To add an object to a tab control, select the tab panel you would like the object to 
reside on, then drag the object onto the panel until it is completely surrounded by 
the tab control.

4. Popovers can be used for situations where you might have needed another 
window including detailed information about other data, map, help text, navigation 
bar. 

5. Web viewers can go to websites based on field data, allowing them to dynamically 
search the web.
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Lesson 12
Formatting Field Objects

Time: This lesson takes approximately 20 minutes 
to complete.

File: Equipment Rentals.fmp12



Objectives

After this lesson, you will be able to:

• Format a date, number, or time field object

• Apply Conditional Formatting to a field

• Change the Control Styles for a field

• Create a static value list

Users spend much of their time viewing and editing data in the solution. FileMaker has 
many options to formatting data which creates a consistent experience for users. 
Developers can also speed up the entry of data by providing users with pop-up menus, 
drop-down calendars, and more. 

In this lesson, you will learn about the different ways to format dates, times, and 
numbers, the options for formatting objects based on certain conditions, and controls 
for data entry.
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Data Formatting
In addition to specifying attributes of your data including font and color, FileMaker Pro 
allows you to display numbers and dates with special formatting—such as currency, a 
percent, a specific date format, and so on. The Inspector helps you apply these types 
of formatting at the object level.

By default, the formatting for a date field will be As Entered. If a user types 6/7/2013 or 
6.7.2013, the user would see the values exactly as the user entered it. On a list view 
layout, inconsistency in formatting can make it harder to scan and quickly read the data.

With Data Formatting, you have the flexibility to format that data in numerous ways for 
consistency, while users can enter data in any format they wish.

Activity 12.1: Applying Formatting to Fields
You will change the formatting on the date fields so they will show consistently, 
regardless how the user entered the data.

1. Navigate to the Asset Details - iPad layout

2. Enter Layout mode and open the Inspector.

3. Select the In Service Date and Purchase Date fields by holding down the Shift 
key and clicking on both fields.

4. In the Inspector, choose the Data tab. The last section is titled Data Formatting. 

5. Click on the Format drop-down to see all the date formatting options. 

6. Choose the format that shows the date in MM/DD/YY (12/25/03) format. In the 
example above, regardless of how the user enters the date, it will now display on 
this layout as 6/7/13.

7. Change the data formatting for the Cost field by choosing Currency and setting 
the Fixed number of decimals: to 2.

8. Increase the width of the Cost field so that you will be able to see the result (Figure 
63). Return to Browse mode.
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FIGURE 63

Formatting fields is a common practice in order to keep your data looking consistent. 
Often, numbers are shown as currency for a price field and as a percentage for a margin 
field. Time fields can be set to 12 or 24 hour formatting. For Container fields, you can 
specify whether the original proportions will be maintained, as well as if the user will be 
able to interact with certain file types, like PDFs and videos.

155



Conditional Formatting
Conditional formatting allows you to change the look of an object based on specified 
rules. By doing so, you can draw a user's attention to data that might be missing, 
incorrect, or outside of certain boundaries. For example, you can specify that a field 
have a red background color when it is empty, and white when the field contains a 
value. Or, a price field might display bold and red if its value is greater than $5,000.

Activity 12.2: Using Conditional Formatting
You will apply conditional formatting to the Cost field. If the cost is more than $1,000, 
the cost will appear in blue.

1. On the Asset Details - iPad layout, in Layout mode, select the Cost field.

2. Choose Format > Conditional.... A window will appear, allowing you to set the 
criteria that will activate the conditional formatting.

3. Click Add.

4. In the Condition section, change between to greater than, then type "1000".

5. In the Format section, activate Text Color and choose a bright blue, as shown in 
Figure 64 and click OK.

FIGURE 64

6. Enter Browse mode and look at different records. Notice that any value over 1000 
(but not equal to 1000) shows as blue text.
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Field Control Styles
Whenever people manually type in data, misspelling and inconsistencies occur. Field 
control styles are used to format how users interact with fields. The two primary benefits 
of field control styles are:

• Users can enter data faster

• Your data will be more accurate and consistent

To set the control style for a specific field, open the Inspector and use the Field section 
of the Data tab.

There are six different control styles. They are:

• Edit Box: This is a standard field for free form data entry. An Edit Box can have a 
vertical scroll bar, and have the option to auto-complete data from previously 
entered values.

• Drop-down List: You can use this style to enable users to choose an item from a 
value list, or to manually enter a value. Use this option when there are a large 
number of values to choose from.

• Pop-up Menu: To use this style, you must click on the menu to activate it, then see 
your available choices. This style is good when there are only a few items in the list, 
because the pop-up menu grows to show all the possible choices.

• Checkbox Set: This style presents the value list as a set of checkboxes that people 
can select and deselect. More than one checkbox can be selected.

• Radio Button Set: Radio buttons are similar to checkboxes, except that clicking 
one radio button causes a different radio button to be deselected—so only one value 
is selected at a time. This style is appropriate for lists with exclusive choices, such 
as yes or no.

• Drop-down Calendar: This control style allows people to select a small drop-down 
calendar, then enter a date into a field.
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Value Lists
Value lists in FileMaker Pro help facilitate rapid data entry and minimize the possibility of 
data errors, misspellings or inconsistency. Instead of requiring a user to type something 
like a project status, you can set up a value list so the user can choose Active, Inactive, 
or Pending from a drop-down list or a radio button set.

A value list can be made of static values, like the project status example above, or it can 
be a dynamic list, which means that the values are drawn from a table in your FileMaker 
solution. This type of dynamic list is used frequently for selecting the value for a foreign 
key field.

In the Equipment Rentals file, the Category field in the Assets table is a great candidate 
for a drop-down list, especially if the values that can be entered are consistent. The 
Equipment Rental discovery phase provided information about incorrect and misspelled 
values in the data. By setting the field with a drop-down list, there is less chance for 
error in data entry.

Activity 12.3: Using Field Controls and Value Lists
1. On the Asset Details - iPad layout, enter Layout mode.

2. Add the Category field to the layout, below Customer ID and above Item.

3. Click on the Category field. In the Inspector, choose the Data tab. In the Field 
section, click on the Control Style list and choose Drop-down list.

4. Click on the pencil icon next to Values from. This will bring up the Manage Value 
List dialog. Click New.

5. Name the value list Categories.

6. Type the following into the custom values, as shown in Figure 65:

Appliances
Cameras
Computers
Office Furniture
Telephones
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FIGURE 65

7. Click OK to close the Edit Value List. Click OK again to close the Manage Value 
Lists dialogs.

8. Switch to Browse mode and click in the Category field. From now on, when a 
user clicks in the Category field, the list of values will appear.

Similar to conditional formatting, field control styles are applied per object. If you want 
to add a drop-down list to any instance of the Asset's Category field on a layout, you 
will need to edit each instance.
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Review Questions
1. What is the main goal of data formatting?

2. How can conditional formatting help users?

3. How can field control styles improve data consistency?

4. What are the two types of value lists?
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Answers
1. The goal of data formatting is to make data look consistent and not dependent on 

user entry.

2. Conditional formatting helps draws users attention to important data on a layout 
by affecting the objects styles.

3. Field control styles improves data consistency by allowing users to select from a 
set of values instead of typing free form.

4. The two types of value lists are static (using custom values) and dynamic (using 
values from a field).
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Lesson 13
User Interface Best Practices

Time: This lesson takes approximately 5 minutes 
to complete.



Objectives

After this lesson, you will be able to:

• Create layouts with a purpose

• Create better layouts for touch devices

• Create layouts with a pleasing, consistent experience

The last four lessons demonstrated many of the tools for building interfaces in 
FileMaker. With all of the options at your disposal, it is helpful to have some guidelines 
for building the best possible solution for your users. 

This lesson will provide you with a list of best practices for building interfaces in 
FileMaker, including guidelines for the support of multiple devices, the usage of color 
and styles, and the need for a consistent and predictable interface.
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User Interface Best Practices
Here are some guidelines for you to follow when building your solutions.

• Build Layouts for each device type - For the best user experience, you will want to 
create layouts for each device. For example, use one layout for an iPhone, a different 
one for an iPad, and yet another for a laptop or a large desktop display. Each device 
has unique properties. Building separate layouts for each device ensures that your 
solution is the best it can be on each type of device.

• Purpose - The purpose of each screen should be clear and easy to understand. 
Users should quickly be able to figure out what the layout is for and take action.

• Hierarchy - Each screen should have a clear, well-defined hierarchy of information. 
This helps users zero in on their most-needed information.

• Touch - When building for iOS devices, buttons should be a minimum of 44pt x 44pt 
to ensure they can be easily tapped with a finger.

• Avoid typing when possible - On a touch interface, typing is not always the optimal 
input method. Even on a computer or web browser, less typing is more efficient. 
Utilize intelligent default field values, value lists, and date pickers.

• Color - You can enhance the presentation of information using the judicious use of 
color. However, be careful because too much color can easily become distracting 
and difficult for the user to process. Your user interface should not compete with the 
data it is presenting.

• Proximity and Grouping - Items that are close together should be logically related 
to one another. Grouping fields together can segment the workflow and helps users 
to find information easily. 

• Design Patterns and Grids - Your solution may be unique, but you don’t have to 
reinvent the wheel. Use common design patterns and the Apple Human Interface 
Guidelines to capitalize on models that users are already familiar with. Use grids as a 
framework for how information will be presented. Designing on a grid helps maintain 
grouping, spacing and consistency across different screens.

• Whitespace - Make sure that the layout is not crowded with too many objects. It is 
better to have more screens that are concise in their design and purpose, than one 
large screen that tries to cram every type of information onto it. Let your layouts 
breathe.
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• Consistency - Use a consistent design model throughout your solution. In other 
words, think through your system for all the different kinds of screens you might 
need to create, and apply your methodology the same way in all parts of the system. 
Once users become familiar with the presentation of information and the actions of 
objects in one area, they can count on other parts of the system working the same 
way.

Read the Human Interface Guidelines
The iOS Human Interface Guidelines describe the principles that help you design a 
superlative user interface for iOS apps. These principles are just as important for 
solutions you build with the FileMaker Platform as they are for apps built for the App 
Store.

Apple's iOS Human Interface Guidelines can be found here: 
https://developer.apple.com/library/ios/documentation/UserExperience/Conceptual/
MobileHIG/

Read the FileMaker WebDirect Guide
When creating webpages with FileMaker WebDirect, it is important to follow best 
practices for web design. The FileMaker WebDirect Guide will give you the information 
you need. This includes everything from using web-safe fonts and colors to only 
including the objects your users need on each page for faster page load.

The FileMaker WebDirect Guide can be found here: 
https://fmhelp.filemaker.com/docs/13/en/fm13_webdirect_guide.pdf
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Review Questions
1. How does having a clear hierarchy help a user interact with a solution?

2. What should be the minimum size of a button on a touch device?

3. What way of inputing data should be avoided when possible in a touch solution?

4. Why is consistency of the interface across a solution helpful?
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Answers
1. Having a clear hierarchy helps users zero in on the content they need.

2. Buttons should be at least 44pt x 44pt.

3. Typing with the onscreen keyboard should be avoided when possible.

4. Consistency of the interface across a solution helps users become familiar with 
your solution by making new areas of the solution to work the same way as other 
areas.
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Lesson 14
Calculations

Time: This lesson takes approximately 20 minutes 
to complete.

File: Equipment Rentals.fmp12



Objectives

After this lesson, you will be able to:

• Use the Specify Calculation dialog to define calculation fields

• Use Functions to manipulate data

• Use Operators to perform math and compare data

Calculations are a key tool for solution logic. Solution logic lets users complete tasks 
quickly and efficiently. It can also be used to control data updates and other processes 
resulting in better data integrity.

You will use calculation functions for many tasks while you work with a FileMaker 
solution. These tasks include displaying calculation field results, field auto-entry and 
validation, displaying tooltips, filtering portals, displaying conditional formatting, and 
various scripted operations. Because you will use calculation functions so often, 
mastering them is essential.

Here is what you learned about Calculations from the Getting Started Tour.

• Creating Solutions > Calculations

FileMaker Pro can perform simple and complex calculations on your data. For 
example, you can calculate a discounted price based on a list price and a 
discount percentage.

Your calculations can include text, number, date, time, and container data.
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Creating Calculations
Specify Calculation Dialog
All calculations in a FileMaker solution are defined using the Specify Calculation dialog. 
The Specify Calculation dialog allows you to work with fields, operators, and functions 
to create a formula. In certain cases, you can also control the result type and storage.

Figure 66 shows the Specify Calculation dialog for defining a calculation field. You can 
double-click the fields, operators, and functions to insert them into the formula entry 
space. If you prefer, you can also type them manually. 

When defining calculation fields, you can specify the result type at the bottom left of the 
Specify Calculation dialog. The result type dictates how the output will be interpreted 
by FileMaker Pro. Set the result type to that expected of the calculation. For example, 
the formula Get(CurrentDate) + 14 would be expected to return a date 14 days from 
today. The formula FirstName & " " & LastName would be expected to return text that 
is the person’s full name. The formula UnitPrice * Quantity would be expected to return 
the total cost for a group of items purchased together.

FIGURE 66
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Creating Calculation Fields
A requirement for the Equipment Rentals file, is that it provides users with two specific 
pieces of information: the number of days a Customer has leased an Asset and the total 
cost of a Customer’s Assets. Calculation fields can be used to accomplish both of these 
tasks. 

Activity 14.1: Creating a "Days Leased" Number Calculation Field
First you will define a field to calculate the number of days a Customer has leased an 
Asset. For this solution, the number of days leased is the difference between the current 
date and In Service Date.

1. Navigate to the Fields tab of the Manage Database dialog. Choose the Assets 
table in the Table drop-down, if it is not already selected.

2. Type Num Days Leased in the Field Name box.

3. Choose Calculation as the Field Type.

4. Click Create.

5. Type the formula Get(CurrentDate) - In Service Date in the formula 
entry space.

6. Choose Number for the result type in the lower left corner of the dialog.

7. Click OK to exit the Specify Calculation dialog and click OK again to exit the 
Manage Database dialog.

8. Add the Num Days Leased field to the Asset Details - iPad layout, shown in 
Figure 67 and check the results of the calculation by modifying the In Service 
Date field on a few records.
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FIGURE 67
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Functions and Operators
Functions
Functions are used in calculations to perform specific tasks and return a result. Many 
functions accept data as a parameter and will manipulate that data to produce a result. 
For example, the Length function takes a single text parameter and returns the length 
of that text:

Length ( "Eugene" )

Result: 6

There are hundreds of calculation functions. The types of calculation functions available 
include text, number, date, time, text formatting, financial, aggregate, Get functions, and 
more. 

Get functions are noteworthy because many of these functions provide information 
regarding the user’s current session. This gives you access to information like the user’s 
account name, the current layout, the type of device being used, and the current date 
and time.

Activity 14.2: Creating a "Total Cost of Assets" Number 
Calculation Field
Next, you will create a calculation field to determine the total cost of a Customer’s 
Asset, which is the sum of the Cost field across all of the Assets attached to a 
Customer.

1. Navigate to the Fields tab of the Manage Database dialog. Choose the 
Customers table in the Table drop-down.

2. Type "Total Cost of Assets" in the Field Name box.

3. Choose Calculation as the Field Type.

4. Click Create.

5. Type the formula Sum(Assets::Cost)in the formula entry space.

6. The calculation result in the lower left corner of the dialog should be set to 
Number.
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7. Click OK to exit the Specify Calculation dialog and click OK again to exit the 
Manage Database dialog.

8. Add the Total Cost of Assets field to the Customer Details layout as shown in 
Figure 68 and check the results of the calculation. The Total Cost of Assets field 
should equal the sum of the Cost field from each of the Customer’s related Asset 
records. 

FIGURE 68

Operators
In addition to the many functions available, operators will often be required in order to 
achieve the desired calculation result. FileMaker Pro provides the following operators for 
use in calculations:

• Standard math operators: Add, subtract, multiply, and divide

• Text operators: Ampersand, which is used to append one string to another; carriage 
return (¶); quotes for specifying literal text; and parentheses to manage the order of 
operations

• Logical operators: <, >, and, or, not, and so on

When using math operators, the order of operations in calculation formulae follows the 
rules of standard mathematics. Expressions within parentheses are evaluated first, then 
multiplication and division from left to right, then addition and subtraction from left to 
right. For example: 8 – 3 * ( 1 + 1 ) returns 2.

Text operators allow you to combine two or more text items into one larger item. For 
example, the formula FirstName & " " & LastName would return a person’s full name. 
Note that a space is needed within quotes to properly separate the contents of the 
FirstName and LastName fields.
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Next to the operator buttons are the logical operators, which are used to compare two 
expressions and return a true or false (1 or 0) result. This is known as a Boolean result. 
For example, (grade > 80 and grade ≤ 89) will return a value of 1, or true, when the 
grade field contains a number greater than 80 but less than or equal to 89.

Activity 15.3: Creating a Text Calculation Field
In this activity you will create a Full Address calculation field. 

1. Navigate to the Fields tab of the Manage Database dialog. Choose the 
Customers table in the Table drop-down if it is not already selected.

2. Type “Full Address” in the Field Name box.

3. Choose Calculation as the Field Type.

4. Click Create.

5. Type the formula Address & "¶" & City & ", " & State & " " & 
Zip in the formula entry space.

6. The calculation result in the lower left corner of the dialog should be set to Text.

7. Click OK to exit the Specify Calculation dialog and click OK again to exit the 
Manage Database dialog.

8. Add the Full Address field to the Customer Details layout. The calculation result 
in the Full Address field should look similar to Figure 69.

FIGURE 69
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There are many other things you can do with calculations. For example, you can create 
a calculated status field that compares an Invoice’s due date with the current date and 
returns either "Open" or "Overdue". Another common use of calculations is to create 
display fields that concatenate data from multiple fields into a desirable format. You 
might create display fields for Full Name or Address, for example.
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Review Questions
1. What are the three types of objects you can add to a calculation?

2. What do Get functions return?

3. What is a function?

4. What are the different types of operators?

177



Answers
1. The three types of objects you can add to a calculation are fields, operators, and 

functions.

2. The Get functions returns information about the user’s current session.

3. A function is used in a calculation to perform a task and produce a result.

4. The three different types of operators are math, text, and logical.
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Lesson 15
Scripting

Time: This lesson takes approximately 20 minutes 
to complete.



Objectives

After this lesson, you will be able to:

• Create, Edit, and Organize scripts

• Attach scripts to buttons

• Trigger scripts when opening a solution

Scripting is another important aspect of solution logic. Scripting is a very powerful tool 
in FileMaker Pro that allows you to specify a series of actions that can be triggered in a 
variety of ways. Scripts can serve many purposes, from simple navigation tasks to 
complex reporting and workflow needs. Scripts can be called via buttons on layouts as 
well as via script triggers, which activate a script when a certain action happens, like 
entering a layout, navigating between records, or opening a file.

Here is what you learned about Scripting from the Getting Started Tour.

• Creating Solutions > Scripts

With FileMaker Pro scripts, you can automate tasks like creating reports or 
emailing customers.

A script is a set of instructions, called script steps.

Simple scripts can perform a single task. Complex scripts can combine elements 
(such as user feedback) with programming techniques (such as branching and 
looping).
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What are Scripts?
A script is a sequence of instructions that accomplish a particular task. For example, 
Figure 70 shows a script that can create a new contact record by performing these 
tasks:

• Navigating to the Contacts layout

• Creating a new record

• Entering default data into two fields

• Placing the cursor in the title field so the user can begin typing immediately

FIGURE 70

It may be helpful to think of creating a script as writing a recipe for cooking. A recipe 
provides instructions (measuring, chopping, mixing, stirring, and simmering) in a 
particular order while working with a list of ingredients to produce a desired result. 
Some recipes (and scripts) are simple, while others more complex and time-intensive.
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Script Steps
A script is composed of script steps. Each script step is a specific instruction of 
the complete script which defines the task. The script steps are pre-defined 
commands that you select from a list. There are more than 150 script steps that 
perform actions such as navigating to a layout, creating and deleting records, and 
performing finds.

Most script steps are based on menu items. For example, frequently used menu 
items such as New Record, Enter Find Mode, and Import Records are all script 
steps. This makes scripting easier to learn for users who are familiar with using 
solutions in Browse and Find mode.
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Creating and Editing Scripts
You can create, edit, and manage scripts using the Manage Scripts command in 
FileMaker Pro. If you have access privileges in the file, you can access the Manage 
Scripts window using either of these methods:

• Choose Manage Scripts from the Scripts menu.

• Use the keyboard shortcut Command-Shift-S in OS X or Ctrl-Shift-S in Windows.

An example of the Manage Scripts window is shown in Figure 71. 

FIGURE 71
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All of the scripts created for a given database file are listed in the Manage Scripts 
window. In a new file that was not created from a Starter Solution, the Manage Scripts 
window will be blank, no scripts will appear. Your job is to add scripts to automate 
repetitive tasks and to provide controls for users of the solution. Scripts can simplify 
and enhance the user experience.

Organizing Scripts
Scripts can be organized into folders for easy grouping and retrieval. A FileMaker 
solution can easily contain many scripts, so keep your scripts organized to save time 
and effort. Two tools at the top of the Manage Scripts window allow you to easily find 
scripts that you have written:

• The pop-up menu in the upper left corner of the window lets you view the contents 
of a single folder.

• The text box in the upper right corner allows you to filter the script list. As you type 
in characters, only those scripts with that character string in their name will appear. 
The filter applies only to the folder chosen in the menu unless the Show All option is 
selected.

You can move scripts by clicking the up-down arrow icon or the script name and 
dragging the script to a new location.

You can delete scripts by using either of these methods:

• Use the Delete button at the bottom of the window.

• Press the Backspace or Delete key after selecting one or more scripts.

Be careful when you delete scripts, the delete action cannot be undone and may have 
serious consequences for how parts of your FileMaker solution function (or cease to 
function).

The checkbox to the left of each script name indicates whether that script is listed in the 
Scripts menu. Users can trigger these scripts directly from the menu. Usually you will 
list only high level control scripts in the menu, such as Logout, Go to Menu, Login 
again, and Help, but you can decide what makes sense for your solution.
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Writing Scripts
To create a script, click the New button in the Manage Scripts dialog. An Edit Script 
dialog opens, shown previously in Figure 70. By default, all new scripts are named 
"New Script". Script names need not be unique, but it is a best practice to make 
names that are unique and that describe the purpose of the script.

All of the individual script steps are listed on the left side of the Edit Script dialog. You 
can add a script step to your script using either of these methods:

• Double-click the script step in the list on the left.

• Select the script step, then click the Move button (or press Return).

FileMaker Pro does not limit the length of scripts or the number of steps that scripts can 
perform.

Not every script step is valid for every FileMaker environment. If you are writing a script 
intended for a FileMaker Go user, for example, limit your script to only those script steps 
that can be executed on iOS devices. The Show Compatibility option at the bottom left 
of the Edit Script dialog allows you to choose a target platform, such as iOS or 
FileMaker WebDirect. Script steps that are incompatible with the selected platform will 
be greyed out.

When a step in a script is selected, you can view and specify step options in the Script 
Step Options portion of the Edit Script dialog. As you learn new script steps, you will 
learn about the options available to you. (Options for each script step are discussed 
fully in FileMaker Pro online help.)

You can save a script by choosing Save Script from the Scripts menu, or by using the 
keyboard shortcut Command-S in OS X or Ctrl-S in Windows. You can always identify 
a script with unsaved changes because you will see an asterisk (*) at the end of the 
script name in the title of the Edit Script dialog. If you try to close the Edit Script dialog 
(or run the script) before you have saved it, FileMaker Pro will prompt you to save the 
script.
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Triggering Scripts
After you have created a script, you must decide how and when it will be triggered. 
Scripts can be triggered in many different ways in FileMaker solutions, including:

• Any object on a layout can be defined to be a button and programmed to perform a 
script when a user clicks it. This option is described in detail in the next section, 
"Buttons".

• Scripts listed in the Scripts menu can be triggered manually by choosing the script 
item from the menu (or by using a keyboard shortcut, when available).

• Scripts can be defined to run (call) other scripts.

• If you choose File Options from the File menu, you can define a script to trigger 
when any window opens, when the first window opens, when any window closes, 
and when the last window closes.

• You can define layout or object-level script triggers to run as users interact with your 
solution. Some examples of actions that can trigger a script are navigating to a 
layout, clicking or tabbing out of a field, or entering Browse or Find mode.
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Buttons
You can make most objects on a layout behave as if it were a button that triggers a 
script, or you can use the Button tool to create a button object.

To access the Button Setup dialog for an object shown in Figure 72, use either of these 
methods:

• Control-click (or right-click in Windows) the object and choose Button Setup from 
the contextual menu.

• Select the object and choose Button Setup from the Format menu.

FIGURE 72

Typically in the Button Setup dialog, you choose Perform Script from the list of 
available script steps, then specify which script to trigger. Buttons can also perform 
single script steps, which can be useful for very simple navigation (for example, Go To 
Layout) or record creating.

187



There are a couple scripts that need to be created in the Equipment Rentals solution to 
make it more user friendly. The first is a script to navigate to a list of Customers from the 
Customer Details layout, and the other is a startup script to navigate to the appropriate 
layout upon opening the file depending on the user’s device. These are examples of 
useful navigation features that will make it easier for users to access different areas of a 
solution and find specific data.

As we learned in Lesson 10: Layout Design Tools, when creating a new layout for an iOS 
device, FileMaker Pro will create a script that is attached to the layout as a script trigger. 
The script locks the zoom feature on the device, which prevents the layout from 
zooming in if a user accidentally double-taps on it. Therefore, you'll already have two 
scripts in the Manage Scripts dialog.

Activity 15.1: Creating a Navigation Script
Create a script that will allow the user to navigate to the Customer List layout from the 
Customer Details layout. You will add a button to the Customer Details layout that 
performs this script.

1. Open the Manage Scripts dialog by choosing Scripts > Manage Scripts... or by 
using the keyboard shortcut Command-Shift-S (OS X) or Ctrl-Shift-S (Windows).

2. Click the New button in the lower left hand corner of the dialog. Change the name 
of the script to "Go to Customer List".

3. Double-click the Go to Layout script step in the list of script steps to move it into 
the script editing area.

4. Click on the newly added Go to Layout step and choose Layout... in the Specify 
drop-down in the lower right hand corner of the dialog.

5. Choose the Customer List layout and click OK.

6. Save the script by choosing Scripts > Save Script or by pressing Command-S 
(OS X) or Ctrl-S (Windows) and close the Edit Script and Manage Scripts 
windows.

7. Navigate to the Customer Details layout and enter Layout mode.

8. Select the Button tool (  icon) from the Status Toolbar. Click and drag on the 
layout to create a button object in the header. The Button Setup dialog will appear.

9. Choose Perform Script from the list of script steps on the left hand side.
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10. Click Specify... and choose the Go to Customer List script. Click OK and then 
click OK again to exit the Button Setup dialog.

11. Type Customer List as the button text, save the layout, and enter Browse mode. 
The Customer Details layout should now look like Figure 73.

FIGURE 73

Test the button to make sure it correctly navigates to the Customer List layout. The 
current record and found set do not change when navigating to the Customer List 
using this button; it simply navigates to the Customer List layout and displays the 
same set of records.
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Single Step Scripts
Because this script only contains one script step, the same action could be 
accomplished by having the button execute the Go to Layout script step directly 
(rather than executing the Perform Script script step). Most script steps are 
available to be specified as a button’s action in the left hand side of the Button 
Setup dialog. The limitation with this approach is that only one step can be 
specified. A script is required for a button to perform multiple script steps in a 
sequence. It is generally considered a best practice to define scripts for all buttons 
in a solution, especially if the action will be repeated in more than one location in 
the solution. This is helpful if you need to add a step to the process like sorting the 
records displayed in the list. Updating a single script would be much more efficient 
than reviewing your entire solution and updating all the buttons that reference a 
certain script step.
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Startup Script
It is useful to have a script execute when a user opens a solution. Common uses for this 
type of script are:

• Displaying a layout specifically designed for iOS if the user is using an iOS device 

• Navigating to a different table based on the needs of different user groups. 

You will explore how to use the OnFirstWindowOpen script trigger to accomplish this.

For the Equipment Rentals file, iOS users are mainly technicians whose responsibilities 
include delivering, installing, and repairing assets for customers and are only interested 
in working with asset records. The desktop users of the solution are the Equipment 
Providers, Inc.'s account managers who are more interested in viewing customers than 
assets because they routinely call or send letters to customers. To help these different 
types of users be more productive, the startup script in the Equipment Rentals solution 
should navigate to the appropriate area depending on the device being used. 

Activity 15.2: Creating a Startup Script
You will use a combination of the If script step and the Get(Device) function to check 
the user’s device and have the script take different steps accordingly.

1. Open the Manage Scripts dialog.

2. Create a new script named Startup.

3. Double-click the If script step to add it to the script. An End If step is automatically 
added to the script because every If step requires an End If step to be considered 
valid.

4. Select the If step and click Specify... or double-click on the If step to bring up the 
Specify Calculation dialog.

5. Enter the formula Get(Device) = 3. The Get(Device) function returns 3 if 
the user is on an iPad. 

6. Click OK to exit the Specify Calculation dialog.

7. Add a Go to Layout script step to the script. Place the step directly after the If 
script step but before the End If script step by clicking and dragging it into 
position. 
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8. Change the Go to Layout script step to navigate to the Asset Details - iPad 
layout.

9. Double-click the Else If script step to add it to the script. The Else If step allows 
you to specify another condition to evaluate if the condition specified in the If step 
is false. The Else If step will only be executed when the condition specified in the 
If step is false.

10. Select the Else If step and click Specify... or double-click on the Else If step to 
bring up the Specify Calculation dialog.

11. Enter the formula Get(Device) = 4. The Get(Device) function returns 4 if 
the user is on an iPhone or iPod touch.

12. Add a Go to Layout script step between the Else If and End If script step. 
Change the Go to Layout script step to navigate to the Asset Details - iPhone 
layout.

13. Add an Else script step directly after the last Go to Layout script step but before 
the End If script step. The Else script step allows you to specify what the script 
should do if the conditions specified in the If and Else If steps are false, meaning 
the user is not using an iOS device.

14. Add a Go to Layout script step immediately following the Else script step. Specify 
that this Go to Layout script step navigates to the Customer List layout. The 
script should look similar to Figure 74.
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FIGURE 74

15. Save the script and close both the Edit Script and Manage Scripts dialogs.

16. Choose File > File Options... and go to the Script Triggers tab.

17. Check the box next to OnFirstWindowOpen and choose the Startup script. Click 
OK twice to close the Specify Script and File Options... dialogs.

To test the script, open the Equipment Rentals file from an iOS device. Refer to the 
deployment section for detailed instructions on transferring the file to an iOS device and 
opening the file with FileMaker Go.
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If you do not have access to an iOS device, you can test that the script is executing 
properly on your computer by navigating to the Asset Details - iPad layout, closing the 
file, then reopening the file. FileMaker Pro’s default behavior would be to open the file 
with the last used layout, which was Asset Details - iPad layout displayed in this case, 
but if the Startup script executes properly, the file will open to the Customer List layout 
instead.
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Review Questions
1. Where do a majority of script steps come from?

2. How do you configure a layout object to activate a script when the user clicks it?

3. What does the OnFirstWindowOpen script trigger allow developers to do?
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Answers
1. A majority of script steps come from menu items in Browse, Find, and Preview 

modes.

2. Any object on a layout can be turned into a button by using the Button Setup 
dialog, which is accessible from the object’s contextual menu, or by choosing 
Format > Button Setup. Set the button to Perform Script and select the script 
you want to trigger.

3. Developers can create startup scripts to run when the solution first opens which 
can take users to layouts built for their needs using the OnFirstWindowOpen 
script trigger.
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Lesson 16
Reporting

Time: This lesson takes approximately 20 minutes 
to complete.

File: Equipment Rentals.fmp12



Objectives

After this lesson, you will be able to:

• Describe how a subsummary report works

• Explain the concept of break field

• Set up subsummary and grand summary parts

• Define and use summary fields

• Create basic subsummary reports

• Create a chart using Quick Charts

One of the most powerful features of FileMaker solutions is its ability to combine data 
and summarize it in a report. With the right reports, you can gain insight into your 
business or meet your internal or regulatory compliance requirements. You can use the 
data to aggregate, organize, synthesize, summarize, and manage it. To create effective 
reports, you will need to know how to define fields, develop layouts, define calculations, 
and use scripts. In other words, you will need to harness the skills that you learned in 
previous lessons.

In this lesson, you will work with dynamic subsummary data to create a basic 
subsummary report. The reporting tools in FileMaker Pro are the building blocks for your 
most advanced reporting tasks. You will also learn how to make a chart using Quick 
Charts.

Here is what you learned about layouts from the Getting Started Tour.

• Getting Started > Charts

Create charts to compare and contrast data. You can chart individual data values 
(single items sold) or summary data (total sales per quarter)

• Getting Started > Reporting

FileMaker Pro can generate reports to help you organize and analyze your data.

You can create custom reports by grouping data. Summary reports can include 
subtotals and grand totals.

FileMaker Pro can print your report or email it as an Excel or PDF file.
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Subsummary Reports
Before you begin building a report, you need to plan what kind of report you want. For 
the Equipment Rentals file, management has asked for a report that shows the total 
cost of Assets per Category so they can evaluate whether investment in assets is 
properly diversified across the different categories.

You can generate different reports using the same interface by using different data sets. 
For example, a layout that summarizes Assets by Category can potentially present all 
Assets or only those Assets that are currently in service.

The most powerful type of report in FileMaker Pro is the subsummary report which 
presents a list of data grouped by a specific value. In the Equipment Rentals solution, 
you have the data shown in Figure 75.

FIGURE 75

One report you can generate from this data is a subsummary by Category as shown in 
Figure 76. 
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FIGURE 76

As you can see, this kind of report groups all the assets under a subheader for each 
category. Additionally, you can include a row at the bottom of each category that 
displays the total cost of assets in that category using a summary field.

When creating a subsummary report, the field used to group records is called the break 
field. In this example, Category is the break field. Typically, the break field is a field that 
contains repeating data across multiple records—such as category, type, status, and 
month—rather than a continuous or free entry field like amount, description, and 
comment. Whenever the break field value changes, the report "breaks" and starts a new 
subsummary group.

Unlike creating layouts that require you to use the Field Picker, FileMaker Pro walks 
you through creating a report, including adding fields and adding subtotals and totals.
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Subsummary Parts
To group records, you need to use a subsummary part. A subsummary part is a layout 
part that displays information for each group of records when the found set is sorted by 
the break field specified in the part definition for the subsummary part. The subsummary 
part and its contents are not displayed if the found set is not sorted by the break field.

It is often useful to have two subsummary parts on a layout, one above the body and 
one below the body, with the same break field. This allows you to display a descriptive 
header for each group as well as a total or other aggregated data below the group. 
Figure 76 illustrates this approach. The header is the Category, and the aggregated data 
is the total cost of assets per Category.

You can also have many subsummary parts on a layout with different break fields 
specified. This is useful for displaying subgroups within groups. As long as you include 
the different break fields in your sort order, the records will be grouped by each break 
field.

Using multiple subsummary parts on a single layout can also be useful for reusing your 
report layout to create reports that are grouped by different fields. Because 
subsummary parts are only displayed when the found set is sorted by the part’s break 
field, all you would need to do to change the grouping on the report is sort the found set 
by a different break field.

Summary Fields
Grouping records becomes more valuable when you utilize summary fields to aggregate 
data for each group. A summary field aggregates data across a group of records. 
Summary fields are created via the Manage Database dialog. You can choose options 
for summary fields through the Options for Summary Field dialog as shown in Figure 
77. The most common summary operations you will use are Total, Average, and Count.
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FIGURE 77

When a summary field is placed in a header, footer, body, or grand summary part, it 
aggregates the values from a specified field across all records in the found set. When a 
summary field is placed in a subsummary part, it displays aggregate information about 
each subgroup of records. This means you can use the same summary field to total the 
cost of assets for each category in a subsummary part, and also to total the cost of all 
assets in the found set in a grand summary part.

Activity 16.1: Creating a Subsummary Report
1. Go to Layout mode and choose Layouts > New Layout/Report....

2. Choose Assets in the Show records from drop-down and name the new layout 
"Asset Report".

3. Click on Computer and then choose Report. Click Continue.

4. Make sure the options to include subtotals and grand totals are activated and click 
Next.

5. Double-click on the following fields from the Assets table to specify them for the 
report:

• Asset ID
• Item

• Purchase Date
• In Service Date
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• Cost

• Category

6. Click Next.

7. Double-click on Category in the Organize Records by Category screen. Click 
Next.

8. Double-click on In Service Date to also sort by that field in addition to Category. 
Your screen should look like Figure 78, then click Next.

FIGURE 78

9. Under Summary field, click Specify.... You have not yet created a summary field.

10. Click Add. Name the field Cost Total, choose Total of from the options on the left 
side of the dialog, and choose Cost from the field names.

11. Click OK to create the field and click OK again to choose the newly created field. 

12. Click Add Subtotal and click Next.

13. On the Specify Grand Totals screen click Specify...,choose Cost Total, and click 
OK.

14. Click Add Grand Total and click Next.
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15. On the Header and Footer Information screen, choose Layout Name in the 
drop-down for Top left and Current Date in the drop-down for Bottom right. 
Click Next.

16. Click Create a script, name it "Asset Report", and check the Run script 
automatically checkbox. This will add an OnLayoutEnter Script Trigger so that 
when a user goes to the Asset Report layout, the script will automatically sort the 
records. Click Finish.

17. Remove the Category field from the Body, along with its label in the Header.

A new layout will be created with the fields, subsummary parts, and the trailing grand 
summary that you specified. The process will do its best to properly size fields, but 
some adjustment might be needed. After resizing and moving fields, and applying the 
Vibrant theme and data formatting, your report should look similar to Figure 79. Note 
that after exiting Layout mode you may need to run the Asset Report script by 
choosing Scripts > Asset Report in order for the report to be grouped correctly. Notice 
that the Category field has been removed from the body part in Figure 79. Since the 
report will always sort, it is unnecessary to show the Category on each row.

FIGURE 79
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After performing a find on any layout based on Assets, running the Asset Report script 
by choosing Scripts > Asset Report will take you to the report layout with the same 
found set and sort the data. This allows you to reuse the report with any found set.
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Charts
Visual displays of information are often easier to understand than written versions of the 
same information. For example, charts can help illustrate changes in prices over time, 
the relative performance of a group of students, and much more.

There are two ways to create charts in FileMaker Pro. The first method, using the Quick 
Chart feature, gives users the ability to chart their data in just a few minutes. The 
second method offers greater flexibility and involves placing a chart object on a layout 
and manually defining the data series to be rendered. You can move, resize, and 
manipulate a chart object just as you do other layout objects, and you can customize 
the colors, fonts, and backgrounds of a chart. When using FileMaker Go and FileMaker 
WebDirect, charts can be viewed but not created or edited.

In FileMaker Pro, you can create ten types of charts: column, stacked column, positive/
negative column, bar, stacked bar, line, area, pie, scatter, and bubble. Over time, you 
will learn which types of charts are best for different types of data, so you can 
communicate your data more effectively.

Quick Charts
The easiest way to familiarize yourself with the charting features of FileMaker Pro is to 
experiment with Quick Charts. Quick Charts can be created from any layout in 
Browse mode. They are based on the current found set and the current sort order, so 
check both before you generate a Quick Chart to make sure they contain the data you 
want to use.

Activity 16.2: Creating a Quick Chart
You will create a Quick Chart that shows the number of Assets per Category for the 
found set.

1. Go to the Asset Details - iPad layout. 

2. Click Show All in the Status Toolbar if you aren’t showing all records.

3. Sort the data by the Category field.

4. Right-click in the Category field and choose Chart by Category.... The Chart 
Setup dialog will appear, as shown in Figure 80. 
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FIGURE 80

5. Change the Title of the chart to "Assets By Category".

6. Click on the Styles panel and change the Chart Style to Shaded - 3D.

7. Click the Save as Layout... button to save the chart as a new layout.

8. Name the new layout "Assets By Category" and click OK.

The newly created chart layout will automatically appear in a new window. Note that 
FileMaker Pro automatically creates a script with the same name as the layout and 
assigns it to the OnLayoutEnter script trigger for the new layout. It is necessary to sort 
your found set by Category in order to display the chart and the script takes care of 
that for you.
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Review Questions
1. What is a break field, and how do you use it to define a subsummary part?

2. How do you add a new subsummary part to a layout?

3. Name the three common summary operations, and explain what results they return 
for a group of records.

4. When does a subsummary part appear in Browse mode?

5. What FileMaker product allows you to create Quick Charts?

6. Which FileMaker products can you use to view charts?
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Answers
1. Use a break field to divide a found set of records into groups. When you create a 

subsummary part, you specify the break field. When the records are sorted by the 
break field and the value of the break field changes, the report "breaks" by 
displaying a subsummary and starting a new subsummary group.

2. To add a subsummary part to a layout, go to the Layouts menu, then choose Part 
Setup to use the Part Setup dialog. Create the new part, then define the option to 
be Sub-summary when sorted by. Choose the break field you want from the list 
of fields in the Part Definition dialog.

3. The most common summary field operations are to total, count, or average the 
values from a particular field. Total adds the values for all records in the specified 
field; Count lists the number of records that contain a value in the specified field; 
and Average finds the average for all the values in the specified field—in other 
words, empty records are not included. For a set of five records that contain field 
values of 100, blank, 200, 300, and 200, the total is 800, the count is 4, and the 
average is 200.

4. A subsummary part appears only when you sort records by the field you define as 
the break field for the subsummary part.

5. Only FileMaker Pro can be used to create Quick Charts.

6. FileMaker Pro, FileMaker Go, and FileMaker WebDirect can all view charts.
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Lesson 17
Integration

Time: This lesson takes approximately 20 minutes 
to complete.



Objectives

After this lesson, you will be able to:

• Export data in common formats

• Save layouts to PDF

• Describe the differences between FileMaker’s ODBC options

The FileMaker Platform uses industry standards to allow it to share information with 
other technologies, whether FileMaker is the data source or looks to other sources. 
FileMaker’s comprehensive integration services include:

• Importing from common file formats such as Excel and comma- or tab-separated

• Importing from XML, ODBC or Bento data sources

• Exporting to common formats such as Excel, comma- or tab-separated text, XML 
and HTML

• Saving data to PDF files and appending data to existing PDF files

• Live connection to SQL data sources (Oracle, MySQL, Microsoft SQL Server)

• Using ODBC/JDBC to access other data sources

• Serving as ODBC and JDBC data sources

• Accessing the source code of web pages

• Supporting HTML5 via the Web Viewer

• Authenticating with Active Directory and Open Directory

• Supporting plug-ins to extend functionality

FileMaker may also initiate and steer activity in the local operating system with:

• Support for AppleScript on OS X and the ability to launch a VBScript file on 
Windows OS.

• The ability to send email, dial phones, and generate event commands to local 
applications (such as to bring other applications to the foreground).
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• Support for custom URL protocols to open FileMaker files, pass variables to and run 
scripts in

• FileMaker files on all platforms, and to allow interaction with other applications and 
apps (for instance to use the TAPI protocol to dial phones on Windows, and to 
interact with barcode scanners in iOS).

Here is what you learned about layouts from the Getting Started Tour.

• Getting Started > Exporting Records

You can export data to another FileMaker Pro file or to another file format, such 
as Microsoft Excel.

FileMaker Pro exports a copy of your data, leaving the original data in the 
database.
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Sharing Data With Outside Users
The FileMaker Platform provides many options for sharing data with other people 
without access to FileMaker. You can export data to multiple file formats. One popular 
example is exporting mailing address data share with colleagues. FileMaker Pro also 
allows you to share by creating a PDF of your layouts. This can be used to generate 
data driven communication like letters, invoices, or estimates. You can even save 
records as Microsoft Excel files with a single command.

Exporting Records
FileMaker Pro enables you to export data to other file formats, allowing data from a 
FileMaker solution to be viewed in other applications. The supported export file formats 
are:

• FileMaker Pro (.fmp12)

• HTML table (.html)

• Merge (.mer)

• Microsoft Excel (.xlsx)

• Tab-Separated Text (.tab or .txt)

• Comma-Separated Text (.csv or .txt)

• XML (.xml)

• dBase format (.dbf)

There are two commands in the File menu to export data:

• Export Records - select which fields to export and the file format.

• Save/Send Records As - automatically exports the fields on the current layout to 
either a PDF or Excel file. 

Both methods export the current found set, which is useful for exporting a specific data 
set after performing a find, such as all active clients or current month orders.
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Activity 17.1: Using Export Records
In this example you will export a HTML table of customer addresses for a direct mail 
service.

1. Navigate to the Customer Details layout and click Show All Records in the 
Status Toolbar.

2. In the File menu, choose Export Records....

3. Name the file “Customer Export” and choose the Desktop as the save location.

4. In the Type pop up menu, choose HTML Table and click Save.

5. In the Specify Field Order for Export dialog, move the Company, Address, City, 
State, and Zip fields to the Field export order box on the right, as shown in Figure 
81, by double-clicking each field or selecting the field on the left and clicking the 
Move button.

FIGURE 81

6. Click the Export button and open the newly created Customer Export.htm file to 
verify the results.
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Saving as a PDF
FileMaker Pro has built-in functionality for saving data as Adobe® PDF files. A user can 
create a PDF file that matches the current layout’s printed output and can easily be 
shared with stakeholders. To do this, go to the File menu and select Save/Send 
Records As > PDF....

There are many options available when saving data as a PDF file, including the ability to 
specify the creator, title, and keywords, and to password protect the file. You can also 
choose to create a new email with the file attached and/or set the file to automatically 
open after saving. Using a script, you can also append new pages to an existing PDF.
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Integrating with Other Data Sources
Integrating a FileMaker solution with external systems can enhance the value of a 
solution and extend its capabilities. Sometimes it may be necessary to retrieve data 
from or send data to an external system. It may be that there is an existing system that 
serves a specific purpose well but FileMaker Pro is used for the majority of the workflow 
and reporting for your workgroup. Or perhaps the external system is the database for a 
publicly accessible website and FileMaker Pro better suits the needs of your workgroup.
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What is ODBC?
You have seen how to incorporate the Web in a FileMaker Pro solution but what if you 
need to import data from another system or have your FileMaker solution serve as the 
data source for another application? To do this, you will need to utilize the ODBC 
capabilities of the FileMaker platform. Open Database Connectivity (ODBC) is the 
technology that allows FileMaker Pro to access data from external data sources as well 
as act as the data source for another system. 

For the most part, the ODBC data sources FileMaker Pro can connect to use the SQL 
database language but ODBC can be used to connect to other data sources as long as 
a compatible ODBC driver is available and installed on your computer and the proper 
Data Source Name (DSN) is set up. 

Examples of database applications FileMaker Pro can connect to using ODBC include 
(but are not limited to) Microsoft SQL Server, MySQL, Oracle, and Microsoft Access.

There are three different ways to interact with an ODBC data source: External SQL 
Sources (ESS), Importing from an ODBC data source, and the Execute SQL script step. 
The following sections will cover the basics of these three methods. 

External SQL Sources (ESS)
ESS is a feature that allows you to add tables from remote SQL sources directly to the 
Relationships Graph in FileMaker Pro and work with them as though they were native 
FileMaker tables. Your users can search for, create, edit, and delete records in the SQL 
data table directly. You can also create direct relationships between FileMaker tables 
and SQL tables and view live SQL data alongside FileMaker data. 

When using the ESS feature in files hosted via FileMaker Server, it is possible to 
configure ODBC drivers and DSNs only on the server machine, rather than on each 
individual desktop running FileMaker Pro. The seamless integration of the SQL table 
into FileMaker Pro and the consolidation of the ODBC driver and DSN setup to the 
server machine make ESS the preferred method of integrating with SQL data sources. 

ESS is limited to Oracle, MySQL and Microsoft SQL Server. Consult the FileMaker 
website for more information, including appropriate drivers.
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Import from ODBC Data Sources
Importing records from an ODBC data source is a one-way form of integration between 
the ODBC data source and your FileMaker Pro database. Using this technique, there is 
no way to edit the data that exists in the ODBC source. After importing the data into 
FileMaker Pro it is possible to edit the data, but the changes will not be reflected in the 
original data source.

Unlike ESS, this import capability will work with any ODBC data source for which you 
can access an appropriate driver, allowing FileMaker Pro to interact with a wide variety 
of ODBC-based data sources. 

To import records from an ODBC source, you will need to have the appropriate ODBC 
driver installed on each computer from which you intend to use the feature, as well as 
an appropriate DSN configured on each machine. This is unlike the ESS feature that 
permits the consolidation of drivers and DSNs onto the server alone.

Execute SQL Script Step
The Execute SQL script step allows a FileMaker Pro solution to send SQL statements 
to a remote SQL data source. In some ways, it is the mirror image of the ODBC import 
functionality. While the ODBC import capability can search for and import records, but 
not change data in the ODBC data source, the Execute SQL script step can run 
commands that change data in the ODBC data source, but cannot retrieve and display 
records within FileMaker Pro. The two features used together can thus provide a full, 
two-way integration with an ODBC data source.

This feature, like the ODBC import feature, relies on ODBC drivers and DSNs installed 
on each FileMaker Pro client computer and will work with a very wide variety of ODBC 
drivers and data sources. The Execute SQL script step requires knowledge of SQL to 
apply effectively. ESS allows users to search for, create, edit, and delete records in a 
SQL data table directly without writing any SQL.
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Review Questions
1. What are the two ways to export data out of your solution?

2. What file formats can Save/Send Records As… produce?

3. What are the major benefits to using ESS (External SQL Sources) over the other 
ODBC techniques?
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Answers
1. Two ways to export data out of your solution are Export Records and Save/Send 

Records As….

2. The file formats Save/Send Records As… can produce Excel and PDF.

3. ESS allows users to search for, create, edit, and delete records in a SQL data table 
directly without writing any SQL. Also FileMaker Server can manage the 
connection, therefore removing the need to install ODBC drivers on multiple 
devices, and allowing FileMaker Go and FileMaker WebDirect clients to view data 
from the SQL source.
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Lesson 18
Security

Time: This lesson takes approximately 20 minutes 
to complete.



Objectives

After this lesson, you will be able to:

• Explain the purposes of accounts, passwords, and privilege sets

• Enable and disable the default login account

• Create and manage accounts and privilege sets

• Explain how external authentication works and why it is useful

• Articulate the purpose of the reauthentication extended privilege

Security is a primary concern for both developers and end users. It governs whether or 
not a person can open a given file and determines which functions and data are 
accessible.

This lesson will introduce you to FileMaker Platform’s built-in security. You will 
incorporate many different aspects of FileMaker security into the Equipment Rentals file.

Depending on your security compliance and certification requirements, there may be 
other features that you will need to learn beyond what is covered here.

When securing a solution there are three principles to consider:

• Confidentiality — You have a responsibility to ensure that unauthorized people 
cannot access the data.

• Integrity — You have a responsibility to allow authorized users to create and update 
data while preventing unintentional changes. You must also restrict access to 
unauthorized users who may tamper with the files.

• Availability — You have a responsibility to ensure that the data is available to users 
when it is needed. 

The FileMaker security model is based on two key components:

1. Accounts — identifies the individual user

2. Privilege Sets — defines access limits for user(s)

In this lesson, you will learn about these two key components.
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Prompt for Login
The first step when dealing with security is to change the default login settings 
configured automatically when you create a new FileMaker Pro file. By default, a new 
FileMaker Pro file contains an account named Admin, with no password, assigned to 
the [Full Access] privilege set. The file is configured to automatically login with this 
account. The Full Access privilege set allows unrestricted access to the file, including 
all development functions. As long as this default login remains in place, security is 
effectively bypassed. 

Activity 18.1: Enable Security settings
The Equipment Rentals file currently has the default security settings. Change the 
default settings to prompt users for a password, and give the Admin account a 
password.

1. Choose File > File Options... and uncheck the Log in using checkbox (Figure 82).

FIGURE 82

2. Click OK. The automatic login behavior is now disabled. The next required step in 
securing the file is to enter a password for the Admin account.

3. Choose File > Manage > Security... to open the Manage Security dialog, shown 
in Figure 83.
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FIGURE 83

4. Double-click the Admin account in the list of accounts.

5. Enter abcde for the password and click OK. Click OK again to close the Manage 
Security dialog.

6. On the Confirm Full Access Login dialog, enter Admin as the full access account 
and abcde as the password and click OK.

To test these changes, close and reopen the file. You should now be prompted to login 
when you attempt to open the file. Keep admin passwords in a secure place. If they are 
lost, you may not be able to gain full access to the file again. Note that passwords are 
case sensitive but account names are not.
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Accounts
An account and password combination is the primary means of authenticating a user 
and is required to access any FileMaker solution. You can create as many accounts in 
your FileMaker solution as necessary and each account is given specific access 
privileges by assigning it to a privilege set.

Accounts can be authenticated either internally or externally. With internal 
authentication (via FileMaker), the account name and password are stored within the 
database file itself.

One of the benefits of using internal authentication is that all of the security setup in a 
solution can be done exclusively in FileMaker Pro without the need for an external 
server or FileMaker Server software. This makes it the quicker and easier option for 
managing accounts.

With external authentication (often via Open Directory or Active Directory) FileMaker 
only stores user group names and interacts with an external server to authenticate a 
user’s account and password. External authentication requires that the database is 
hosted with FileMaker Server and that FileMaker Server be configured to allow external 
authentication (enabled by a single checkbox in the FileMaker Server Admin Console). 

External authentication still requires a user to provide an account name and password, 
but instead of FileMaker Server verifying those credentials itself, it passes the 
credentials are passed through to the directory service. The directory service verifies the 
user’s credentials and sends back a list of all the groups to which the user belongs. This 
list is then compared to the group names in your FileMaker file, and the first valid match 
determines the privilege set available to the user. 

One of the benefits of external authentication is that you do not need to set up 
individual user credentials in every FileMaker file in your solution. The solution access 
can be centrally managed using the same tools most organizations have in place for 
granting access to other network services. This can save you a lot of time if your 
solution contains many FileMaker files. 

Another benefit is that users do not have to memorize solution-specific credentials. The 
same credentials that give them access to their other company systems also give them 
access to the databases that they need to access.
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It is common practice to have an account for each user, whether the account 
information is stored internally or externally. This is useful because it allows you to track 
who is creating or modifying individual records or taking other actions in your solution. 
You can accomplish this using auto-enter field settings or by using the 
Get(AccountName) function in calculations and scripts. The functionality to track this 
information works the same with both internal and external authentication.
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Privilege Sets
A privilege set is a specific set of rights given to one or more accounts to access certain 
parts of your system, such as data, layouts, fields, and scripts. By default, a new 
FileMaker Pro file contains three predefined privilege sets:

• Full Access—Allows users to have complete access to the file, including all 
development functions (which are required for access to the Manage Database and 
Manage Security dialogs).

• Data Entry Only—Allows users to create, edit, and delete records and to import and 
export data. Users cannot access any development functions.

• Read-Only Access—Allows users to view and export record data. Users cannot 
modify the file.

Developers and administrators of a database are usually given accounts associated 
with the [Full Access] privilege set. [Full Access] privileges are required to access the 
Manage Database and Manage Security dialogs, and no other privilege set can be 
configured to grant these abilities.

You cannot change or delete these predefined privilege sets, except to assign extended 
privileges. You can, however, create new privilege sets to meet your specific 
requirements. 

A privilege set can be used by any number of accounts. Typically one account is 
created for each user, and a privilege set for each user group. User groups could be 
defined as the different departments that use a solution (Sales, Accounting, Marketing, 
etc.) or a hierarchy of positions within a company (Staff, Managers, Executives, etc.) for 
example. 

Privilege Sets comprise the following access options:

• Data Access and Design Privileges—Provide access to a wide range of security 
control, including records, layouts, value lists, and scripts.

• Extended Privileges—Determine the data access methods that are permitted for a 
privilege set.

• Other Privileges—Allow printing, exporting, and some other functions.
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One noteworthy feature of the Data Access and Design privileges is the ability to 
define privileges for specific tables, fields, layouts, scripts, and value lists by using the 
Custom Privileges... option. You can even use a calculation formula to determine 
record access privileges. For example, you could allow a user to edit only records 
assigned to him or her based on the user’s account name. Using calculations for record 
level privileges is covered in more detail in FileMaker Training Series: Advanced, Module 
7 (Security). 

Up until this point, the Equipment Rentals file only has the default accounts and 
privilege sets. In this task you will create a new privilege set and then create a new 
account assigned to the new privilege set. The requirements state that the users of the 
solution will need to be able to edit all Asset data but only view Customer data. They 
should not be able to delete records in any table. The users will not be doing any layout 
design or scripting. They will also need remote access to the file since it will be hosted 
on a server.

Activity 18.2: Creating Accounts and Privilege Sets
1. Open the Manage Security dialog by choosing File > Manage > Security...

2. Select the Privilege Sets tab and click New...

3. In the Edit Privilege Set dialog, name the privilege set "Technicians", shown in 
Figure 84.

FIGURE 84
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4. Choose Custom Privileges... in the Records drop-down in the Data Access and 
Design section. This will bring up the Custom Record Privileges dialog.

5. Click on the Assets table in the list and choose yes in both the View and Edit 
drop-downs. Choose no in both the Create and Delete drop-downs and choose 
all in the Field Access drop-down.

6. Click on the Customers table in the list and choose yes in the View drop-down 
and choose no in the Edit, Create, and Delete drop-downs. Choose all in the 
Field Access drop-down. Click OK.

7. Specify the following for the remaining Data Access and Design options:

• Layouts: All view only

• Value Lists: All view only
• Scripts: All executable only

8. In the Other Privileges area, check the boxes for Allow printing, Allow 
exporting, and Allow user to modify their own password. Choose All in the 
Available menu commands drop-down.

9. To turn on access to this file when hosted via peer-to-peer or FileMaker Server, in 
the Extended Privileges section, check the box next to Access via FileMaker 
Network (fmapp). The Privilege Set should look the same as Figure 85.

FIGURE 85
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10. Click OK.

11. Choose the Accounts tab and click New....

12. For the Account Name, type "Bob".

13. For the Password, type "12345" and check the box for User must change 
password on next login.

14. Choose Technicians from the Privilege Set drop-down (Figure 86).

15. Click OK twice to close the Edit Account and the Manage Security dialogs. 

16. Enter a Full Access account name and password to save the changes.

FIGURE 86

To test the newly created Technicians privilege set, close the Equipment Rentals file, 
reopen the file, and login with the account Bob. You will be prompted to change the 
password on the account. Change the password to anything you would like. Once 
logged in as Bob, verify that you cannot create or delete records and that you cannot 
modify layouts or scripts. Also verify that you cannot edit Customer records but can edit 
Asset records.

Note: To allow you to open the file, the completed final file does not have a password 
for the Admin account.
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By implementing accounts and privileges in your FileMaker solutions, you are securing 
your data. For Equipment Providers, Inc., the solution will limit access properly for 
Technicians. Other privilege sets could be added to provide other, tailored security 
measures. While security is not a requirement, it is highly recommended in all solutions. 
Now that your FileMaker solution fulfills the needs of Equipment Providers, Inc., the next 
lesson will focus on deploying your solution.

231



Review Questions
1. What is the difference between an account and a privilege set, and how are they 

related to one another?

2. If you open a file using FileMaker Go and are not prompted for a username and 
password, what can you conclude?

3. With how many privilege sets may an account be associated?
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Answers
1. The difference between an account and a privilege set is an account controls your 

ability to open a file, whereas a privilege set governs what you can see and do in 
the file.

2. If you are not prompted for a password, you can conclude that there is a default 
login enabled.

3. Every account, whether authenticated internally or externally, must be associated 
with one and only one privilege set.
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Lesson 19
Deployment

Time: This lesson takes approximately 20 minutes 
to complete.

Files: Equipment Rentals.fmp12



Objectives

After this lesson, you will be able to:

• Describe the differences between peer-to-peer and FileMaker Server 
hosting

• Open files on FileMaker Pro and FileMaker Go

• Transfer local files to FileMaker Go

The term deployment refers to the various means by which FileMaker developers make 
solutions available for use by clients. The term also encompasses the standard 
practices and procedures by which a FileMaker database system is maintained and 
kept running.

From FileMaker Server, to peer-to-peer sharing and local access, there are many ways 
to deploy a solution to multiple users. This lesson reviews the deployment options 
available for FileMaker solutions, discussing the specific advantages of each method 
and when it might be best to use that method.

FileMaker solutions can be shared in 3 different ways:

• Solution can be opened on your device as a standalone file. The file will normally be 
saved locally on the device accessing the file.

• Solution can be hosted for groups of 5 or less by FileMaker Pro for access by 
FileMaker Pro and FileMaker Go users.

• Solution can be hosted by FileMaker Server for larger groups for access by 
FileMaker Pro, FileMaker Go and web browser users. In this case, concurrent 
connections are needed to allow access by FileMaker Go and web browser users.

In this lesson, you will learn about these methods of deployment.
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Network Sharing
While a FileMaker solution can be used by a single user who opens it locally on their 
computer or iOS device, one of the FileMaker platform's most prized features is its 
ability to allow multiple users to access a solution simultaneously. There are two ways 
that a FileMaker solution can be shared by multiple users.

Using FileMaker Pro
FileMaker Pro (or Pro Advanced) can host a solution for as many as five users running 
either FileMaker Pro or FileMaker Go. Peer-to-peer sharing is appropriate when a small 
group of users needs occasional access to files.

There are two steps required to set up peer-to-peer file sharing. First, open the file to be 
shared in FileMaker Pro and enable network file sharing. Then, add the network access 
extended privilege to one or more privilege sets. You can use the FileMaker Network 
Settings dialog shown in Figure 87 to complete both steps. To access it, choose File > 
Sharing > Share with FileMaker Clients....

FIGURE 87
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After enabling Network Sharing, the IP address will appear that users or "guests" can 
use to connect to the hosted file. Select the files you want to share from the Currently 
open files list, and then specify which groups should have network access to the file. 
The file must remain open on the host for a guest to access it.

Once this has been done, a user will be able to make a remote connection to the locally 
hosted file. Details on connecting to a hosted file can be found in the next section.

Using FileMaker Server
FileMaker Server is a dedicated product for sharing and maintaining hosted database 
files. FileMaker Server provides many benefits over peer to peer sharing, including 
backup and script schedules, SSL encryption, and better shared performance. You use 
the FileMaker Server Admin Console shown in Figure 88 to configure and manage 
FileMaker Server. You can use the Admin Console to manage server settings, backup 
and script schedules, monitor server usage, and download database files from a remote 
connection.

FIGURE 88

The latest hardware requirements for FileMaker Server can be found at the FileMaker 
Server Technical Specifications page:

http://www.filemaker.com/products/filemaker-server/server-13-specifications.html
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Opening FileMaker Files
Opening Local Files
Databases that are stored locally on your computer or iOS device can be opened 
directly using FileMaker Pro or FileMaker Go. 

In FileMaker Pro, choose File menu > Open or press Command-O (OS X) or Ctrl-O 
(Windows). You will then prompted to locate the file you wish to open.

In FileMaker Go, after opening the app, the home screen appears. The Home screen 
provides access to recently used files, files on your device, remote hosts, and FileMaker 
Go application settings.

To open a local file, tap the filename in the list of files on the Device panel.

Transferring Files to an iOS Device
There are four methods to transfer files to FileMaker Go so that you can use the files 
locally on your device:

• Connect your device to iTunes through your computer with a USB cable

• Send a FileMaker file to your device through email

• Access a file from a website

• Access a file from another application, such as Dropbox or Box.com

If a file is transferred using any of these methods, the file is copied to the device and will 
be accessible from the Files on Device list within FileMaker Go. 

Activity 19.1: Opening a local FileMaker file with FileMaker Go
You will transfer the Equipment Rentals file to an iOS device and test the functionality in 
FileMaker Go.

1. Connect your iOS device to your computer via USB and open iTunes. 

2. In iTunes, select your iOS device and click the Apps tab.

3. Below File Sharing, choose FileMaker Go from the Apps list, then click Add. 

4. Choose the files to transfer, then click Open.
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5. Open FileMaker Go on your iOS device. Similar to Figure 89, Equipment Rentals 
will appear as a local file. Tap on the file to open it.

FIGURE 89

Based on the opening script, you will be taken to either the Asset Details - iPhone or 
Asset Details - iPad layout, depending on your device.

Note: You can also use one of the other file transfer methods mentioned above.

If a file with the same name already exists, the existing file will not be overwritten. 
Instead a serial number is added to the file name. For example, if the file 
SomeDatabase.fmp12 already exists on your device and then you receive that file 
again in an email, the emailed copy of the file is renamed SomeDatabase 1.fmp12. The 
next integer is used for each additional copy of the same file.
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FileMaker files copied to an iOS device are accessible by a single-user only. This means 
that data entered in a local database will only reside on that device. With additional 
development, it is possible for a local file to interact with a hosted file and synchronize 
data between the two. If your data must be synchronized with other FileMaker files, you 
will need to create a data sync process by using scripting or a commercial syncing 
solution.

Opening Hosted Files
Accessing hosted files in FileMaker Go is similar to the way hosted files are opened in 
FileMaker Pro, including any hosts found on the local network and any hosts saved by 
manually entering their address. Figures 90 and 91 show the FileMaker Go home screen 
with the Hosts panel selected on the iPad and iPhone respectively.

!!
FIGURE 90! ! ! ! ! ! ! FIGURE 91

To open a file on one of the hosts tap on a host to view a list of the files available on that 
host, then tap on a file name to open the file.
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Review Questions
1. What are some benefits to FileMaker Server hosting over peer-to-peer sharing?

2. What are four methods for copying a local file to FileMaker Go?

3. Can a local file interact with a hosted file?
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Answers
1. FileMaker Server can share to more users. It also can protect your data with 

backups and SSL encryption over the network. Using FileMaker Server also allows 
for better performance than peer-to-peer sharing.

2. The four methods for copying a local file to FileMaker Go, are: 1) file can be copied 
to the device by using iTunes, 2) sending the file using email, 3) downloading the 
file from a website, and/or 4) opening the file in a file sharing app like Dropbox or 
Box.com.

3. Yes, local files can interact with hosted files with a combination of file references 
and scripting.
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Conclusion
Congratulations! You have successfully built a FileMaker solution that incorporates 
relationships, layouts, calculations, navigation scripts, reports, and security. More 
importantly, you have a built a solution that solves the needs of a business. 

While the Equipment Rentals solution you just created contains many features, this only 
scratches the surface of FileMaker Pro’s capabilities. To learn more about all of these 
features please proceed to FileMaker Training Series: Advanced.
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